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Chapter 1 Intro/Overview of GIS 

Introduction 
 
By the end of this course, you will have a working knowledge of AutoCAD Map 2000 and be able to use the 
features that this program provides to assist you in your day-to-day activities.   
 
AutoCAD Map for Permitting and Reclamation is part of a three course series provided by TIPS. The first 
course, Cad Applications for Permitting and Reclamation, is meant to teach basic AutoCAD skills, as well 
as to provide exposure to AutoCAD Map and SurvCADD.  The other courses, AutoCAD Map for 
Permitting and Reclamation, and SurvCADD for Reclamation and Permitting, are designed to follow up on 
the knowledge gained from the CAD Applications Course.   
 
We will begin by defining what a GIS is in general.  Then, you will be given a brief overview of the specific 
topics that will be covered in AutoCAD Map 2000 and what types of results you will be seeing from the 
exercises.  The majority of your time in this course will be spent in guided tutorials and doing hands on 
exercises. 

What is GIS? 
 
A GIS is a computer-based system to capture, store, edit, manipulate, analyze, synthesize and display 
geographically referenced information.  The key word being referenced, meaning tied to a real world 
coordinate system – to an actual place. 
 
 

 
 
A GIS database contains coordinates of features on the earth’s surface and tabular information describing 
what the feature represents and its relationships to other features. 
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Data Linkage 
 
 
 
 
 
 
 

 Exact Matching   Non-Exact Matching 
 
 
 
 
      

Hierarchical Matching           Fuzzy                 Matching 
 
 
 
 

Components of a GIS 
 
� Data and Information 

 
� Modeling the Real World 

 
� Hardware/Software 

 
� Results and Application 

 

GIS Functions 
 
 

 
 
 

Data Entry 
 

Data Display 
 
Manipulation and Analysis 
 
Data Management 
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Spatial Operations 
 

Locational 
What data is available for the selected Impoundment? 
 
 

 
 

Conditional 
Where is TDS > 1000 ppm? 
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Patterns 
Which structures are within 300 feet of the active permit? 
 

 

Spatial Data Components 
 
 
 
Two basic types of map information: 
-spatial information, which describes the location and shape of geographic features and their spatial 
relationships to other features, and 
-descriptive information about the features 
 

CAD and GIS – complementary technologies 
 
 
 

AutoCAD 
Graphics with properties 
Properties describe how graphics are drawn 
Focus on automation, storage, and retrieval 
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AutoCAD Map 2000 
Graphics with attributes 
Attributes describe what the graphics represent 
Attributes stored in a relational database 
Focus on display, query, and analysis 
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Chapter 2 Course Overview  

Drawing Sets/Source Drawings 
 
� AutoCAD Map allows users to attach source drawings to the current project. 
� Source drawings can be queried to bring information into an existing drawing, or to create new 

drawings from scratch. 
� A group of source drawings attached to a project is known as a drawing set. 

 
� This box is called the project workspace. 

 

 
 

� This project workspace shows a drawing set attached to the current drawing. 
� Note that some of the drawings are active (red) and some are inactive (white). 
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Import & Export 
� AutoCAD Map allows users to import data and geometry from other GIS and CAD programs, and 

export AutoCAD Map projects to those same programs. 
� The following file types are supported by AutoCAD Map’s import and export tools: 

� ArcView Shapefile (SHP) 
� ESRI Arc/INFO Coverage 
� MapInfo  MIF/MID 
� Intergraph (Microstation DGN) 
� Autodesk MapGuide (SDF) 

 
�This image shows an ArcView *.shp file after it is imported into AutoCAD Map in the 
Import Exercise in Chapter 4. �
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Queries 
� AutoCAD Map users are able to query drawing objects from source drawings to create new maps or 

add data to existing ones. 
� Queries can be based on: 

� Location 
� Properties of the source objects being queried 
� Attached object data 
� External database data attached to an object. 

� As objects are queried into an active project, the properties of the object can be changed to create 
thematic maps. 

� This screen capture shows the map created with the query exercise in Chapter 5 
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Raster Images 
� AutoCAD Map users have additional raster image tools available, including: 

� Insert geo-referenced images with world files 
� Rubber sheet non geo-referenced images to match known points 
� Clip areas of an image that are not needed 
� Set image transparency colors 

� This screen capture shows the collage of images created in the three image exercises in Chapter 6. 
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Coordinate Transformation 
� AutoCAD Map allows users to assign coordinate systems to drawings, and to convert drawing 

objects from one coordinate system to another. 
� AutoCAD Map handles both global coordinate systems (Lat/Lon, UTM, etc.) and local (state plane) 

coordinate systems.  
� This screen capture shows the image collage from the image exercise (UTM 27 Meters) converted to 

the coordinate system of the map from the query exercise (MS State Plane Feet) in the exercise in 
Chapter 7. 
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Drawing Cleanup 
� Drawing Cleanup tools allow AutoCAD Map users to correct errors in the drawing geometry before 

creating topologies. 
� The cleanup tools allow users to fix: 

� Under shoots 
� Over shoots 
� Duplicate objects 
� Clustered nodes 
� Pseudo nodes 
� Break crossing objects 

Object Data 
� Object data allows AutoCAD Map users to attach textual information to drawing objects. 
� Some possible uses of object data are: 

� Details about haulroads in a permit map 
� Information about soil types or strata in a map 
�  Drainage information in a watershed map 
� Distances between points on a core hole map 

� The dialog box below shows the object data that is attached to an object in the exercise in Chapter 9. 
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Topologies 
� Topologies allow users to show a geographic relationship between drawing objects. 
� AutoCAD Map can create the following types of topologies: 

� Node 
� Link 
� Polygon 

� The screen capture below shows the object data that was attached through the topology creation 
exercise in Chapter 10. 
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External Databases 
� AutoCAD Map allows users to attach an external database to a drawing, and then link records in the 

database to drawing objects. 
� This allows users to view the external data related to an object, edit the data, 

and save the changes back to the original database file without leaving 
AutoCAD.  

� This screen capture shows a database with records inked to a drawing object from the exercise in 
Chapter 11. 
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Save Back 
� AutoCAD Map allows users to edit objects that are queried from source drawings, and then save the 

edited objects back to the original drawings. 
� This can save the user a great deal of time, since the changes only have to be 

made in the active drawing, instead of both. 
� The user can also save newly created objects back to the source drawings. 

 
� This screen capture shows objects that are in the Save Set in the exercise in Chapter 12 
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Chapter 3 Source Drawings – Attach/Detach  
 
One of the most important features of AutoCAD Map is its ability to work with data from several source 
drawings at one time.  The process of selecting source drawings, making them available, and repeatedly 
defining certain parameters would be extremely tedious if values had to be entered every time you wanted to 
work with source drawings.  Instead, this information is saved in the current drawing, which is known as a 
project. 
 
A project is the environment in which you perform queries, and view and edit source drawings.  A source 
drawing can be any .dwg file containing data that you want to work with.  Any number of source drawings 
can be used in a project.   
 
In addition to information on the source drawings you want to access and whether those drawings are active 
or not active, the project contains information on saved queries, links to external databases, any coordinate 
system settings, and user preferences.  By using projects, you do not have to open all of your drawings and 
adjust settings each time you work. AutoCAD Map saves a project as a separate .dwg file. 
 
When a project is saved, the current settings for the project and source drawings are also saved in the current 
drawing.  The interface used to handle source drawings and current project drawings is referred to as the 
Project Workspace.  It is fully Windows compliant and supports right-clicking to view shortcut menus, as 
well as drag and drop operations from Windows Explorer. 
 
    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
When you start AutoCAD Map, a new project file appears in the Project Workspace.  If the Project 
Workspace dialog box does not appear, go to the Map drop-down menu and click on Options.  
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In the AutoCAD Map Options dialogue box, on the Workspace tab, check the Show Workspace on startup 
box.  This will cause the Project Workspace box to be displayed on startup.  You can hide the Project 
Workspace by right clicking either on the Project Workspace title bar or in the blank area of the box.  Select 
Hide from the screen menu.  You can also go to the Map drop-down menu; select Utilities and you should 
see a check mark beside Project Workspace.  Click on Project Workspace to un-check and the Project 
Workspace should disappear (it is now hidden).  To bring it back (un-hide), go to Map, Utilities and click 
Project Workspace.  
 
You can also dock the Project Workspace box on the left or right side of the drawing window by right 
clicking in the blank area of the box and selecting Docked from the shortcut menu.  Right-click on the 
header bar of the docked Project Workspace and see that Allow Docking is checked.  If it is checked, you 
can also dock the Project Workspace by left clicking and holding on the title bar and dragging to the left or 
right edge of the drawing window.  If Allow Docking is un-checked, the Project Workspace will not dock by 
clicking and dragging.  To undock the Project Workspace, either double left-click the header bar of the 
docked Project Workspace or left-click, hold and drag the box away from the edge of the drawing window. 
 
 
If you work on the same set of drawings and use queries more than once, you can attach the source drawings 
and save your queries in the project.  AutoCAD Map saves the active project as a .dwg drawing, which is 
known as a project drawing. 
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You can set project options so that when you open that project drawing, AutoCAD Map automatically 
activates the source drawings and connects the databases.  You can also open more than one project at a 
time and switch between projects. 
 
Depending on your current task, you may or may not want to work with data in a project.  The following 
guidelines will help you determine when you should work with data in a project or when you should be 
working with data in a single drawing environment.   
 

Working with data in a single drawing environment 
� Moving data from one drawing to another 
� Creating object data and ASE links 
� Digitizing 
� Drawing Cleanup 
� Import and Export of external file formats 
� Working with Raster Images and setting Display Order 
� Working with Topologies 

Working with data in a Project 
� Querying 
� Using Quick View and Key View 
� Editing source drawings 
� Object Thematic Maps 
� Converting and editing data with different coordinate systems 
� Plot Map Sets 

 
A project can include the following elements: 
 
� Drawing sets 

 
  When you work with AutoCAD Map, you can work with several drawings at the same time.  To 

make sure you always have the set of drawings you want to use, you need to attach the drawings to 
the project.  The group of drawings attached to the project is called a drawing set.  The drawing set 
can include project drawings (a drawing with attached drawings) as well as source drawings.  You 
can attach drawings using the shortcut menu commands in the Project Workspace or use the drag-
and-drop method.  

 
When you save the project, AutoCAD Map saves the path to the attached drawings.  Each time you 
open the project you won’t have to spend time setting up source drawings, keeping track of the 
drawings you need, or remember where they are located. 

 
� External databases 

 
You can store non-graphic information as data in external databases, and access the databases from 
within AutoCAD Map.  You can connect databases to your project, and retrieve objects from source 
drawings based on information in the database.  When you save the project, the program saves the 
connection to the external databases. 

 
� Data View window 

 



AutoCAD Map for Permitting and Reclamation Chapter3 Attach Detach Source Drawings 

18 

After connecting an external database to your project, you can use the Data View window to view 
the information in the database in tabular format.  You can use the Data View to link records in the 
database with objects in the drawing, and then select, highlight, and view specific records and 
objects. 

 
� Saved queries 

 
A query is a set of conditions that defines the subset of objects you want to retrieve from source 
drawings.  For example, you can retrieve all objects within a defined permit boundary or all the soil 
polygons of a specific soil type.  If you want to use the query more than once, you can save it in the 
Query Library.  There are two methods for saving queries: internal and external.  Internal queries are 
stored in the project drawing and are only available from within that project. 

 
External queries are stored independently and are useful because you can share them with other 
users.  You can edit externally saved queries by editing the query files. 

 
 
� Key View definition 

 
The Key View feature lets you quickly view different layers in the active source drawings depending 
on the zoom magnification.  When you set up key view definitions, you specify which layers to 
display at a given zoom magnification.  If your drawings are organized in layers of varying detail, 
you can view major features when you zoom the drawing extent, and view details when you zoom 
in.  You must organize drawings by layers to use Key View. 
 

� Link templates containing path information to external databases 
 

A link template is an alias for the connection between the project and an external database table.  
Use the Define Link Template operation to create link templates.  Use the Generate Links operation 
to create links between objects in your drawing and rows in a table.  When you save the project 
drawing, the link template is saved with the drawing. 

  
� Global coordinate system setting 

 
A global coordinate system code identifies the mapping projection parameters used when a map 
drawing is created.  For example, OK83-NF is the code for the NAD83 Oklahoma State Planes, 
North Zone, US Foot global coordinate system. 

 
When working with maps in AutoCAD Map, you can tag each source drawing with the appropriate 
global coordinate system code.  You can then specify a global coordinate system for the project.  As 
a result, you can work with map drawings with different mapping projections. 

 
When you query to retrieve objects, AutoCAD Map automatically converts them from the global 
coordinate system in the source drawing to the global coordinate system in the project.  When you 
save back to the source drawing, AutoCAD Map restores the objects to the original global coordinate 
system setting. 

 
� Object data tables and records 
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Another way to store non-graphical (text) information about objects is through the use of object data 
stored in the drawing.  This information is organized into object data tables.  The records of these 
tables represent objects to which object data has been attached.  The data for a specific object is 
contained in the fields of its record.  You can define any number of object data tables with any 
number of fields.   

 
The use of object data should be limited.  Object data can greatly increase the size of the drawing 
file.  Object data should be used when data is limited, the data will only be used in AutoCAD Map 
and the data does not change frequently. 

 
These elements will be discussed in detail later throughout this course. 
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DRAWING SETS 
 
You can create a drawing set by attaching the drawings you want to use to the project.  You can easily 
attach and detach drawings from a drawing set, and make them active or inactive for querying.  When you 
execute a query, AutoCAD Map searches only the active drawings and ignores any inactive drawings. 
 
If you plan to share drawings with other users, AutoCAD Map provides a drive alias feature that allows 
different users working with the same projects and drawing sets to locate drawings.  Assume that you, User 
A, are working with a set of drawings located in the E:\TIPS TRAINING\MAP CLASS directory.  You can 
create a drive alias for this path by activating the Define/Modify Drawing Set dialog box.  To do this, do one 
of the following: 
� From the Map menu, choose Drawings < Define/Modify Drawing Set, or 

 
� Right-click the Drawings node in the Project Workspace and choose Define/Modify Drawing Set from the shortcut 

menu. 
 
 
In the Define/Modify Drawing Set dialog box, click Attach. 
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This brings up the Select Drawings to Attach dialog box.  You can also get this dialog box by right-clicking 
the Drawings node in the Project Workspace and choosing Attach from the shortcut menu. 
 
 

 
 

Creating a Drive Alias 
In the Select Drawings To Attach dialog box, click the Create/Edit Aliases button. 
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This brings up the Drive Alias Administration dialog box.   
  
  
  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Under Drive Alias Details, in the Drive Alias box, enter the name of the alias you want to use to represent 
the path.  The name must be unique, use only alphanumeric characters (including hyphen and underscore), 
contain no spaces or colons, and start with a character.  The name can be up to 31 characters long.  For this 
example, lets call this drive alias MAP_CLASS. 
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In the Actual Path box, enter the path to the drawing files you want to use.  You can navigate to the 
appropriate directory using the Browse button.   
 
  
 
 
 
 
 
 
 
 
 
 
 
 
    
 
 

 
 
Once the path is found and entered, click on Add.  This will add the drive alias and its associated path to the 
Drive List window. 
 
  
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
You can modify an existing drive alias by selecting it in the Drive List window.  Make the appropriate 
modifications in the Drive Alias Details boxes.  Then click Update.  
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Attaching Source Drawing Exercise 
 
In this exercise, you will open a blank drawing, then attach, deactivate, activate, and finally detach a group 
of source drawings.  You will also explore the zoom extents and quick view options available when you 
right click on a drawing in the project workspace. 
 
Close any drawings that you might already have open, then go to the File pulldown menu and choose New.  
We will be starting a drawing from scratch with English units. 
 
Once the drawing has come up, go to the Map pulldown, and choose Drawings � Define/Modify Drawing 
Set. 
 

 
 

This will bring up the “Define/Modify Drawing Set” dialog box. 
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In this box, you will need to click “Attach” to add source drawings to the current project.  Clicking “Attach” 
will bring up the dialog box shown below. 
 

 
 
Choose the drive alias that you defined earlier in this chapter that contains the files for the class.  You 
should see a list of files that looks like the one below. 
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From this list of files, you should choose the drawings named HAULRDS, ex2703-1, PRMTBDRY, and 
TWNSHIPS and add them to the list of selected drawings at the bottom (choose the drawing then click Add, 
or simply double click the drawing name in the top half of the box.  After the drawings are added, the icon 
next to the drawings should change from red to white as shown below. 
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After selecting all four drawings, click “OK” to close this dialog box.  Check that all four drawings are 
listed as attached and active in the Define/Modify Drawings Set dialog box and click “OK” in this box also.  
You should now be back to the AutoCAD screen.  Your Project Workspace should look something like the 
one below. 
 

 
 
Now take a few minutes to explore the options that are displayed when you right click on a drawing name.  
In particular, you should deactivate and deactivate the drawings, and also use the zoom extents and quick 
view options.  When you have finished, detach all four of the attached drawings and close the drawing. 
 



AutoCAD Map for Permitting and Reclamation Chapter3 Attach Detach Source Drawings 

28 

Attaching and detaching source drawings will be covered in more detail in Chapter 5 Query Source 
Drawings.  The process described above will be used to attach the drawings to be used to complete the 
examples and exercises in Chapter 5. 
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Chapter 4 Import & Export  
 
AutoCAD Map Import maintains the integrity and nature of mapping and GIS data created in other 
applications, and puts data into as close a data structure as possible to the original file structure.  Links 
between objects in a map and an external database can be maintained when you import or export data. 
 
AutoCAD Map lets you import data from several external file formats including the following: 
 
� ArcView Shapefile (SHP) 

 
� ESRI Arc/INFO Coverage 

 
� MapInfo MIF/MID 

 
� Intergraph (Microstation DGN) 

 
� Autodesk MapGuide (SDF) 

 
You can also export data from AutoCAD Map to these same file formats. 
 
The import and export commands allows the user to: 
 

 
1. Specify a change in a file’s coordinate system 

 
2. Which layers data is placed on 

 
3. How to manipulate blocks 

 
4. Mapping of data elements to object data and 

external databases 
 

 
 
However, you must import all the data in an external file; AutoCAD Map does not allow for selective 
import. 
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Steps for the Import Process: 
 

1. Initiate the Import Command 

 
 

2. Specify the file type 

 
 

3. Specify the file 

 
 

4. Choose Proceed to continue 
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5. Choose data translation options for importing graphical information (vectors) 
 

 
 
The Import Graphics section of the dialog box allows mapping of the external file features to AutoCAD 
Map layers and blocks, as well as performing coordinate conversion.  If Mapping for a set of data has 
already been defined and saved, you can load these settings with the Load button in the Options area. 
 

6. Choose data translation options for importing attribute data 

 
 
The Import Data Elements of the dialog box lets you map data stored in attribute tables to AutoCAD Map 
Object Data tables or external database tables.  You can map to object data or an external database table, but 
not both 
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Object Data tables can be predefined in the current drawing, but the existing object data tables must contain 
the exact same field definitions as the items to be mapped /joined.  
 
Data associated with polygons is mapped to a point (centroid) for that polygon, while data associated with 
arcs and points remains with the arcs and points respectively. 
 
In order to Map Data Elements to an SQL table you must already be connected to a database driver. 
 
When importing data treat it like newly digitized data. 
 

Imported Data Needs 
 
 
 
� Verification 

 
� Cleanup 

 
� Possibly Edge Matching 

 
� Rubbersheeting to Match Existing Maps 
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Exporting Data 
You use the SAVE and WBLOCK commands to maintain the data from a work session in DWG format.  
There are other ways to export data from AutoCAD Map. 
 
The external file formats that AutoCAD Map supports for export have already been discussed in this 
Lesson, however AutoCAD Map also allows ASCII and database files, created by Report queries, to be 
exported. 
 

Steps for the Export Process: 
 

1. Initiate the Export Command 
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2. Select the file format you want to export, then specify the file name and object feature type. 

 
 

3. Specify how you want to select objects for the export. 
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4. Choose Proceed 

 
 

5. Map Export Options dialog box, you can specify a new coordinate system, the mapping for 
layers, block names, object data, or an external database 

 

 
6. Choose Proceed to start the translation. 
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Import Exercise 
 
In this exercise you will add an ArcView Shapefile (SHP).  The .shp file contains the county boundaries for 
the state in which the mine site is located, in this case is Mississippi.  The coordinate system of the file must 
be changed from geographic with units in decimal degrees to planar with units in feet. 
 
Begin by: 
1. Initiating the import command from the Map pull-down menu (the import command is found under 

Tools). 
2. Specify the file type and file to import.  In this example the file type will be ArcView Shape File (*.shp) 

and the file name is Mississippi_Counties.shp 
3. Choose Proceed to continue. 
4. In this example, we first must transform the coordinate system of the file. Check the Perform Coordinate 

Conversion box and click on the Define button. 
5. The Coordinate System Translation dialog box should be visible. The input setting for Category is Lat 

Longs and the Coordinate System is LL27.  The output setting for Category is USA, Mississippi and the 
Coordinate System is MS-E. The Import Data Options and Coordinate System Translation dialog box 
should resemble the one shown below. Then select the OK button on the Coordinate System Translation 
dialog box.  
 

 
6. Next, we will Map the Data Elements to the layer Counties.  Check the box to Map Data Element to 

Layers and select the Layers button.  Select the New button and type in Counties for the New Layer 
Name and select Name from the dropdown menu found under Control Data Element.  Click Select All 
and select the right arrow button (>>) then select OK.  Upon doing this the dialog box should look like 
the following. 
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7. For this example, we are not concerned with the attribute data associated with the objects.  Therefore, 

we will not be importing any data elements associated with the .shp file.  To complete the import, click 
the Proceed button.  You may have to Zoom/Extents, so your drawing screen will look like the one 
below.  At this point, save the drawing to the directory that contains your class files with the name 
import_1.dwg. 
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Chapter 5 Query Source Drawings  
 
One of the most powerful tools available in AutoCAD Map 2000 is the ability to create and run queries.  A 
query is a tool used to retrieve objects and/or data from another drawing.  In earlier versions of AutoCAD, 
this could only be accomplished using external references (xref’s).   
 
The problem that you encounter when using xref’s is that the drawing objects are brought in and handled 
like blocks.  You can view the objects that are brought into the drawing, but when you try to select anything 
that was brought in as an xref, you can’t edit them.  Selecting an xref dependent object selects the entire 
xref, just like selecting a block.  You also cannot explode an xref.  This means that once you bring the 
objects in as an xref, you can only edit them by going back to the original source drawing and changing 
them or going through a fairly complicated process to edit the objects in the current drawing. 
 
Queried objects, on the other hand, are brought into the drawing exactly as they exist in the source drawing.  
Each queried object is brought into the target drawing as an individual drawing object.  They can be edited, 
deleted, copied, etc. just like any other object in the drawing.  On top of this, you can also use the save back 
options of AutoCAD Map to save the changes made to the queried objects back to their original drawings.  
As you can see, the querying and save back capabilities can be very powerful tools for working on projects 
with several drawings that are related to one another. 
 
Another use for queries is making thematic maps.  While you are defining your queries, you can also set 
options for changing the properties of the queried objects.  You can use these options to change layers, line 
types, line widths, add text, or add hatching, just to name a few.  These properties can be changed globally, 
for all queried objects, or you can use object data attached to objects along with range tables to change 
individual objects. 
 
The types of queries that you can define are almost limitless.  There are 4 main query types (location, 
property, data, and SQL), and each of these types has many options that go along with them.  Each of these 
types will be discussed in detail later in this section.  You can also combine any or all of the four query 
types to define a complex query.   
 
The screen capture below shows the Define Query dialog box.  You can display this box several ways.  
First, you could go to the Map pulldown menu, and then choose Query, then Define Query.  
 
 
 
 
 
 
 
 
 
You could also double click on the “Current Query” icon in the Project Workspace, or right click on the 

“Current Query” icon and then choose define.  Another way is to click the “Define Query” button  on 
the Drawing Set toolbar.  Lastly, you could type adequery on the command line.  Any of these will bring up 
the dialog box shown below. 
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Define Query Dialog Box 

 
 
 
The query type selection can be found in the lower left of the dialog box.  This box allows you to chose 
between location, property, Data, and SQL queries.  You can also choose the operator for complex queries.  
The screen captures below show the options that are available for each of the query types. 
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Query Types 
 

Location Queries 
Location queries are based on the spatial location of the object in the source drawing. 
 

 
 
The box above shows the options that are available for location queries.   
� All � Queries everything in the source drawing 
� Buffer Fence � Allows you to query objects using an offset from a fence line.  You may choose 

either an inside selection, which chooses only those objects that are completely within the buffer 
area, or a crossing selection which will choose any objects that are within or crossed by the buffer 
zone. 

� Circle � Allows you to query objects located within a circular area.  You can choose either a 
crossing or an inside circle.   

� Fence � Allows you to query objects that are crossed by a fence line that you define 
� Point ���� Allows you to query objects with a given set of coordinates.  You may either choose the 

coordinates from the screen, or type them on the command line.  
� Polygon � Allows you to query objects from a polygonal area.  You may specify either a crossing 

polygon, or an inside polygon. 
� Polyline � Allows you to choose a polyline in the active drawing to create a polygon, fence or 

buffer fence.  If you choose polygon or buffer fence, you can also choose whether it will be an inside 
or crossing selection. 

� Window � Allows you to choose a rectangular area on the screen to query objects from.  You may 
choose either a crossing or an inside selection window. 
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With each of these options, the query location will be shown on the drawing screen with a red dashed line.  
These lines will remain on the screen until the drawing is refreshed.  Using the Quick View and Zoom 
Extents options in the Project Workspace or from the Map pulldown menu will make it easier to define the 
areas that you would like to query from. 

Property Queries  
Property queries are based on the AutoCAD object properties (layer, color, linetype, width, etc.) for a given 
object. 
 

 
 
Each of the options listed above is a property that you can query the source drawing with.  By selecting a 
property, an operator, and a value, you will be given all objects in the source drawings that have that 
property or set of properties.  You can click on the values button for a list of all of the values for the selected 
property in the source drawings.  You can select a single value, or multiple values by holding the shift or ctrl 
key as you click a value. 

Data Queries 
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Data queries are based on information stored as non-graphical data in a drawing file.  This data can be 
stored as object data, attribute data attached to a block object, or as a link to an external database file.  Data 
queries will retrieve the data that matches the query as well as the objects that the data is attached to.   
 
There are a few limitations to what can actually be queried with the data query options.  If you are trying to 
query based on attribute values, you can only retrieve data and objects that have variable attributes.  If the 
attribute value is set to constant, the query will not bring it in.  Also, if you are trying to use a data query on 
an external database, the query will only bring in objects based on the value in the key column.  To query 
based on any other column, you would have to use an SQL query.  (Databases, link templates, and key 
columns will be discussed in a later section.) 

SQL Queries 
SQL queries are based on information in a linked external database.   
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To run an SQL query, the database that you wish to query from must be attached to the drawing.  The SQL 
query will query objects based on values in any column of the attached database, while the data query would 
only query objects if the specified value matched the value in the key column of the database. 
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Query Modes 
 
After creation of a query, the mode of the query has to be defined.  The three modes are as follows: 

 

Preview 
The preview mode displays queried objects but does not retrieve the objects.  No editing functions are 
available.  The entities are shown on the screen until the next time the drawing is regenerated. 

Draw 
Retrieves queried objects from source drawings or external databases and copies them to the work session 
drawing.  Only one instance of a duplicate object is brought into the target drawing.  At this point the 
entities are available for editing in the current drawing. 

Report 
Directs queried data to an ASCII text file.  The data fields to be displayed are chosen by clicking on the 
Options button.  You can choose to have attributes, database key columns, or SQL data from any column 
written to a text file.  The file created is a CDF (comma delimited format) text file. 
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Query Options 
 
The query options can be used to make changes to the current query or query settings. 

 

 
 

Alter Properties 
 

 
 
Changes the properties of queried objects.  The checkbox must be checked for the changes to take effect.  
Any properties changed using this option are not actually visible until the query is run in draw mode.  In 
preview mode, the changes will not actually be made. 
 
To change the properties for all of the objects queried into the drawing, just choose the property and then 
enter the new value in the expression box (or click the values button and choose the value from the list) and 
click add.  You can also use a range table to change the properties for an object or group of objects based on 
a piece of object data attached to the drawing entity. 
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Save 
Saves the current query settings to a file, within the drawing, or both.  The settings are then available to any 
drawing at any time if they are saved to an external file.  If they are saved internally, you can run that query 
at any time within the drawing.  You must choose a category for the query to be saved under, a name for the 
query, and a name for the external file. 

 
 
To save the query to an external file, check the box beside save to external file.  You are also able to specify 
whether to save the list of active drawings.  This will allow you to specify if you want specific drawings to 
be queried, or if the query should be run on whatever drawings are active in the future.  The save location 
coordinates option allows you to keep the coordinates used for location queries constant.  Otherwise, you 
will have to enter new coordinates each time you run the query. 
 
The save alter properties option lets you keep all property changes with the query.  Auto execute will let you 
specify if you want the query to run automatically when it loads, or if you must click execute query from the 
Define Query dialog box for it to run.  If the box next to Keep Reference in Library is checked, a reference 
to the query will be kept in the Query Library in the Project Workspace. 
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Load 
 

 
 
Retrieves a saved query file for use as the current query.  You can either use a query file saved within the 
current drawing, or you can choose a query that has been saved externally. 

Redraw 
Clears any preview queries performed. 

Zoom Ext 
 

 
 
Allows the user to zoom to the extents of any active drawing in the drawing set.  This helps the user 
visualize where the attached drawings are located relative to the current drawing. 

Drawings 
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Allows the user to attach, detach, activate, and deactivate drawings to be used for the current query. 

More 
 

 
 
Allows the user to change the general query settings for the entire drawing. 
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Query Example 
 
In this example you will create a new map by querying objects from multiple source drawings. 
 
Begin by starting a new drawing from scratch using English units.  The next thing that you must do is attach 
the source drawings.  This can be done several ways 

1. Right click on Drawings in the project workspace, then choose attach. 
2. From the Map Pulldown Menu, choose Drawings � Define/Modify Drawing Set. 
3. Type ADEDRAWINGS on the command line. 

 
Using the Map Pulldown or the command line, you will be taken to the dialog box shown below.  Click on 
the attach button, and you will be given a different box.  This second dialog is the same one that you get by 
right clicking on Drawings in the project workspace and then clicking Attach. 
 

Define/Modify Drawing Set Dialog Box 

 
 
Click the Attach button and you will be given the dialog box below. 
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We will be attaching drawings from the directory that contains our class files, so we use the drive alias that 
was defined earlier in Chapter 3.   Select all of the files located in this folder, and then click Add.  You 
should now have a dialog box that looks something like this. 
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Once you have all of the drawings added, click ok.  If you are taken back to the Define/Modify Drawing Set 
dialog, click OK again to get back to the drawing screen.   
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When you return to the main AutoCAD screen, you should see 
a list of all of the drawings that you just attached in the project 
workspace.   
 
If you right click on any of these drawings listed in the Project 
Workspace, you can choose quick view to see what the 
drawings contains and where it lays within the current drawing.  
The quick view command does the same thing as executing a 
location� all query in preview mode.  It will show the entire 
contents of the source drawing, but it will not actually be 
brought into the current drawing.   
 
You may also choose to zoom to the extents of the source 
drawing.  This is very helpful when you are querying objects 
into an existing drawing and you want to see where the source 
drawing lies in relation to the existing drawing. 
 
The quick view and zoom extents commands can also be used 
before you define a location query.  This will allow you to see 
the objects in the source drawings and define the location query 
from the preview. 
 
 
 
 
 
 
 
 
Now that we have attached the source drawings that we would 
like to query from, we need to define our queries. 
 
Double click on Current Query in the Project workspace to 

bring up the Define Query dialog box.  We will begin by querying contour lines from the source drawings.  
There is a problem with the source drawings though.  The source drawings have each contour elevation on a 
separate layer.  We would like to have the contours on only 2 layers, CTR for the standard contours, and 
CTRINDEX for the 50-foot index contours.  To fix this, we will use a property query by layers, and then 
change the properties as the items are queried. 
 
In the Define Query box, click on Property.  In the property box, choose layer, and then click the values 
button.  You should now be in the Select dialog box shown below.  Each of the numbered layers, from 360 
to 670, represents a different contour elevation.  You will need to choose all of the contour layers that are 
not multiples of 50.  You will need to hold down the CTRL key while you select the layers.  After you have 
selected the layers, click OK, and then click OK in the Property Condition box. 
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You should now be back to the define query box with the query expression showing in the top window. 
 

 
 
We have just defined the layers that we would like to bring into the new drawing.  Now we need to use the 
alter properties button to change the layer that these contours are brought in on.  To do this, click the Alter 
Properties button.  You should get a box that looks like the one below. 
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In the Select Property area, select Layer.  In the box below expression, type CTR, and then click Add.  The 
alteration should show in the window at the top of the box.   
 

 
 
Click OK. 
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You will now be back in the Define Query box.  Click Preview under query mode, and then click Execute 
Query.  If you click OK, the query definition will be saved within AutoCAD Map, but it will not be 
run.   
 
The queried objects should be displayed on the screen now.  If you cannot see them, you may have to zoom 
extents in the drawing.  The property alterations will not take effect until the query is run in draw mode.  If 
you are satisfied with what you see on the screen, double click on Current Query in the project workspace to 
open the Define Query box again.  The query definition should still be in the top window.  
 
Click Draw under Query Mode.  Be sure that the box beside Alter Properties is checked, and then click 
Execute Query.  After you run the query in draw mode, your drawing screen should look something like the 
one below. 
 

 
 
You are now able to edit these objects using any of the editing commands available in AutoCAD.   
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Repeat the process that we just went through to bring in the index contours and place them on the layer 
CTRINDEX. When you first open the Define Query box, you must click Clear Query to get rid of the 
previous query definition.  After choosing the layers to query, go back into the Alter Properties options.  
You will need to click Clear List first, then choose layer and enter CTRINDEX in the expression box.  Click 
Add to add this change to the list.  Before you exit from this box, set the color to red, and the width to 1.  
After you have finished this step, the drawing should look something like the one below. 
 

 
 
The black lines are the 10-foot contours, and the red lines are the 50-foot index contours.  Save this drawing 
as query1.dwg in the directory that contains your class files.  You will be using this drawing in the query 
exercise that begins on the next page.  
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Query Exercise 
 
In this exercise, you will take the contours created in the previous example query_1.dwg (or ch_5_1.dwg 
from the sample files folder) and add different elements from the other attached drawings.  You will use 
both the property and location query types and property alterations to create a complete map. 
 
In this exercise you will perform the following queries and property alterations: 
� Bring in everything on the layer Year_Polys in the drawing ex2703-1.dwg and change the width of 

the lines to 10 and the line color to magenta. 
� Query in all the drill holes in the drawing drillholes.dwg that are located inside the pit lines or that 

are up to 500 feet outside it. 
� Bring the permit boundary in from the drawing PRMTBDRY.dwg; make it red, with a width of 25, 

and a linetype of boundary. 
� Pull in all of the haulroads in the mine area from the drawing haulrds.dwg with no property changes. 
� Bring in all of the ponds in the drawing ponds.dwg and make them blue. 

After all queries have been done, zoom in on the area of the mine covered by the permit boundary.  Your 
drawing should look like the one below.  Save this drawing as query_2.dwg.  This drawing will be used 
again in the coordinate transformation exercise in Chapter 7. 
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Chapter 6 Raster Images  
 
Images can be referenced and placed in drawing files, but like external references (xrefs), they are not 
actually part of the drawing file.  The image is linked to the drawing file through a path name.  Linked 
image paths can be changed or removed at any time.  By attaching images using linked image paths, you 
can place images in your drawing and only slightly increase the drawing file size. 
 
Once you've attached an image, you can reattach it multiple times, treating it as if it were a block.  Each 
insertion has its own clip boundary and its own settings for brightness, contrast, fade, and transparency.  
You can specify the raster image scale factor when you attach the image so that the scale of the geometry in 
the image matches the scale of the geometry in the AutoCAD drawing.  AutoCAD multiplies the image by 
the specified scale.  The default image scale factor is 1, and the default unit for all images is "Unitless."  The 
image file can contain resolution information defining the dots per inch (DPI), relating to how the image 
was scanned.  
 
If an image has resolution information, AutoCAD combines this information with the scale factor and the 
AutoCAD unit of measurement of the drawing to scale the image in your drawing.  For example, if your 
raster image is a scanned blueprint on which the scale is 1 inch equals 50 feet, or 1:600, and your AutoCAD 
drawing is set up so that 1 unit represents 1 inch, then in the Image dialog box under Scale, select Specify 
On-Screen.  To scale the image, you clear Specify On-Screen, and then enter 600 in Scale. AutoCAD then 
attaches the image at a scale that brings the geometry in the image into alignment with the geometry in the 
drawing. 
 
If no resolution information is defined with the attached image file, AutoCAD calculates the image's 
original width to be one unit.  After attaching, the image width in AutoCAD units is equal to the scale 
factor. 
 

Image Correlation 
 
Use the Image Correlation dialog box to correlate an image within the drawing when you insert it. The 
Source tab displays correlation information from the selected correlation source. The Insertion tab shows 
how these settings apply to the current drawing. 
 
Correlation Source list - You can select a correlation source for the image from this list. For example, if a 
resource or world file exists for the image, then it is displayed in this list. 
 

•  Insertion Point area - Contains the insertion point (X, Y, and Z coordinates) for the lower-left corner 
of the image frame. On the Source tab, this information is in the units specified in the Units area at 
the bottom of the tab. On the Insertion tab, this information is in current drawing units. 

 
Rotation box - Contains the amount of rotation in current drawing angle units for the image. This value uses 
the lower-left corner as the base point. 
 
Scale box - Contains a scale factor for the image. A scale factor greater than 1 enlarges the image, while a 
scale factor less than 1 shrinks the image. 
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For example, to make the image twice as large, type 2 in the Scale box. 
 
Density box - Displays the dots (or pixels) per unit for the image. 
 

•  Units list - Select the units for the insertion point and density from this list. For example, if your 
image was scanned at 300 dpi, then select Inches as the unit. 

•  Apply button - Click this button to apply the changes you have made to the insertion point, rotation, 
scale, and frame color. 

•  Pick < button - Click this button (on the Insertion tab) when you want to draw a frame for the image 
you want to insert. For more information, see To Adjust the Frame for the Image You Want to 
Insert. 

 
Frame Color box - Displays the current color for the image frame and for the foreground of a bitonal image. 
Usually this is the current AutoCAD Map color. However, when you insert a bitonal image, AutoCAD Map 
first looks for the foreground color in the image header file or in a resource file. If it cannot find the color 
information, then the foreground color defaults to the current AutoCAD Map color. To change the color, 
click Select (on the Insertion tab). 
 

Geo-referenced Images 
 
Some image files have corresponding information files that establish the relationship between page 
coordinates on a planar map and known real world coordinates.  These image files are referred to as geo-
referenced.   
 
Note: Both the drawing and image must use the same map projection and coordinate system.  (For more 
information see coordinate transformation in Chapter 7). 
 

Image Editing Tools 
 
IMAGEADJUST controls the brightness, contrast, and fade values of images. 
 
IMAGEATTACH attaches a new image object and definition. 
 
IMAGECLIP creates new clipping boundaries for an image object. 
 
IMAGEFRAME controls whether AutoCAD displays the image frame or hides it from view. 
 
IMAGEQUALITY controls the display quality of images. 
 
TRANSPARENCY controls whether the background of images is transparent or opaque. 
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Image Exercise 1:  Inserting a Geo-referenced Image 
In this exercise, you will be inserting a U.S.G.S. Digital Raster Graphic (DRG) with an associated world 
(*.tfw) file into a blank drawing.   
 
At this point, you should close any open drawings, then go to the File pulldown menu and choose New.  
You will be starting a new drawing from scratch with English units.  You can insert an image into any 
drawing file, but for this exercise, you will be using a blank drawing. 
 
Make a Layer named 24K USGS IMAGE and set it to be the current layer. 
 
Go to the Map menu and select Image then Insert. 
Click on the box Modify Correlation if it is not already checked. 
In the Insert Image dialog box, select weir.tif then choose Open. 
 

Note In the Image Correlation dialog box, values for the Insertion Point are taken from the TFW file, 
known as a World file that is associated with that image. 

 
Click OK and you should see the image on your screen.  If the image is not displayed, you should zoom to 
the drawings extents to see it.  Use a zoom window to zoom in on the lower left hand corner of the drawing.  
This area contains the information about the coordinate systems that the image is brought in with.  By 
default, all USGS DRG images are geo-referenced in UTM NAD 27 Meters.  This information, along with 
the UTM Zone is shown in the red box below.  The State Plane Coordinate System information is displayed 
in the blue box below.  This information will be used in Chapter 7, to perform the coordinate conversion.  
 

 
 
You will now use the steps outlined above to insert the three remaining USGS DRG’s (Ackerman.tif, 
Tomnolen.tif, and Reform.tif) to this drawing.  After you have inserted the remaining images, save the 
drawing in the directory that contains your course files as Image_1.dwg.  This drawing will be used in 
Chapter 7 for the coordinate conversion exercise. 
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Take a few minutes to explore some of the image management options that are available in AutoCAD Map.   
 
Click on the outer edge (frame) of an image to select it, then go to the Tools menu and select Display 
Order then Send to Back. 
 
Enter Imageclip at the command prompt to clip the image boundary to trim off the image border.  Select the 
image by picking a point on the image edge, then enter New boundary; Polygonal.  Use the 7.5-minute 
quadrangle boundaries to clip off the map borders. 
 
Enter Imageframe at the command prompt to turn off the image boundary. 
 
Note:  With the images frame turned off you will need to either turn it back on to select the image for future 
editing, or you may select the image with the frame off by holding down the Shift key while selecting the 
image edge with the left mouse button.  Enter Imageframe again to turn the frames back on.   
 
Save and then close the drawing for use later. 
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Image Exercise 2:  Non Geo-referenced Image 
In this exercise, you will be inserting an aerial photo with no world file into the drawings that contains the 
collage of quad maps that you just created.  You will then use this image in the Rubber Sheeting Exercise 
that follows. 
 
Open the drawing Image_1.dwg (or ch_6_1.dwg from the sample files folder) if it is not already open 
Make a Layer named Non_Geo_IMAGE and set it to be the current layer.  Freeze layer 24K USGS 
IMAGE. 
 
Go to the Map menu and select Image then Insert. 
Click on the box Modify Correlation if it is not already checked. 
In the Insert Image dialog box, select ackerman_nw.jpg then choose Open. 
 
In the Image Correlation dialog box, click on the Insertion tab, and then Pick to select the image base point.  
Click anywhere in the lower right quarter of the collage of images.  Enter 0 for the rotation angle, and 
finally enter to take the default Corner Point.  Set the scale in the Image Correlation dialog box to 2000, then 
click OK. 
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The location, scale and rotation of the inserted image will need to be modified to fit the quad map correctly.  
Save this drawing as Image_2.dwg in the directory that contains your course files. 
 

Rubber Sheeting: 
 
Use this command to stretch objects from one set of points to a new set of points. 
 
To use rubber sheeting, define a set of base points for a polygon, and then specify new locations for the base 
points. Selected objects in the polygon are modified as necessary to fit the new polygon.  This command is 
useful if you want to stretch a map or image to fit known control points or monuments. 
 
Warning:  Rubber sheeting can severely compromise the accuracy of your data.  Use it only when 
necessary.  Rubber sheeting may not work as expected on raster objects.  Objects wholly within the original 
polygon are modified to fit the new shape and location of the polygon. 
 
AutoCAD Map 2000 allows you to do 16 point rubber sheeting.  This means that you can use up to 16 pairs 
of base and reference points to perform the rubber sheeting.  The minimum number of points that you need 
to get a good result is 4.  If you use less than 4 points, you will not get correct results.  If it is at all possible, 
your pairs of points should be evenly distributed around the area that you are rubber sheeting, and as close 
to the outside as possible.  If you overload one side with more points, the result will be skewed in that 
direction. 
 

Rubber Sheeting Exercise 
 
Open the drawing Image_2.dwg (or ch_6_2.dwg) from the directory containing your course files. 
 
In this exercise, you will rubber sheet the aerial photo inserted in Exercise 2 to fit to the DRG image 
inserted in Exercise 1.   
 
Go to the Map menu, then select the Map Tools option and highlight Rubber Sheet.   
 
At the command prompt you will be prompted for Base Point 1.  Pick a known base point on the aerial 
photo (in this case, road intersections work well), and then when prompted; pick the corresponding 
reference point on the DRG Image.  Using the transparent pan and zoom commands will make this much 
easier.  Repeat the point selection for at least three more points then press enter. Some possible pairs of 
points are shown below. 
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After all of the Base and Reference Points have been identified you will be prompted to select the objects to 
be transformed.  Type S to select the objects and press enter.  Pick the frame of the aerial photo, then press 
enter.  The aerial photo will be shifted to align with the DRG image.  Save this drawing as Image_3.dwg in 
the directory that contains your course files. 
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Chapter 7 Global Coordinate Systems – Define/Assign/Transform  

AutoCAD Map 2000: Converting Drawing Coordinate Systems 
This procedure will explain how to convert drawings from one coordinate system to another using 
AutoCAD Map 2000.  
 
For Map to successfully produce the conversion, it needs to be told the coordinate system of the original and 
target drawings. 

Assigning the systems 

1. Start AutoCAD Map with either a new, empty drawing or an existing drawing that contains drawing 
objects.  

2. From the Map pulldown, choose Tools, then Assign Global Coordinate System. You should be 
given a dialog box like the one shown below. 
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3. Choose the ‘Select Coordinate System’ button in the 'Active Project' section to bring up the 'Global 
Coordinate Systems’ dialog as shown below. 

 
4. The category drop down list shows all of the available coordinate systems that are loaded in 

AutoCAD Map.  
5. The list of 'Coordinate Systems in Category' gives the different datum, zone, and unit options that 

are available in each category 
6. After choosing the proper category and coordinate system, choose OK to return to the ‘Assign 

Global Coordinate System’ dialog box.  The appropriate code for the coordinate system that you 
choose should show in the ‘Code’ box.  

7. In the middle 'Source Drawings' section, choose the Select Drawings button. You will now be able to 
select the desired drawing(s) to apply a coordinate system to.  You may apply a coordinate system to 
as many source drawings as you wish.  You may also “mix and match” source drawings with several 
different coordinate systems.   After you choose the Source drawings to apply a coordinate system 
to, choose OK.  You will be returned to the Assign Coordinate System dialog box.  The middle of 
the assignment dialog should display the number of drawings that are selected to assign a system to.  

8. Choose the ‘Select Coordinate System’ button in the center of the source drawing area to bring up 
the 'Global Coordinate Systems’ dialog again.  This is where you will assign a coordinate system to 
the source drawings.  This box is exactly the same as the box that you got in the Current Project area.  
After you have chosen a coordinate system for the source drawings, click OK to return to the 
‘Assign Global Coordinate System’ dialog.  You can now either click OK to exit the dialog box.   

9. To assign a different coordinate system to other source drawings, simply go through the process 
again, with the different drawings and assign the different system.  

At this point we have assigned coordinate systems to the current project and the source drawings and are 
ready to proceed to querying the objects into the current (target) drawing. 

Attaching the Source Drawing 

At this point we have informed Map about what coordinate system the source drawings are in, but have not 
attached them as source drawings.  To do this, you will follow the procedures given in Chapter 3.  

 

1. From the Map pulldown, choose Drawings, Define/Modify Drawing Set.  
2. Choose the Attach button, select, and add the source drawings.  
3. The dialog should now show your drawings attached and active, then choose OK.  
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Querying the Objects 
AutoCAD Map does the transformation as drawing objects are being queried into the current drawing.  So 
the next step is to setup a simple query to import all of the objects.  Querying source drawings was covered 
in Chapter 5.  Brief instructions are given below to do a simple query to convert an entire drawing from one 
coordinate system to another. 

1. From the Map pulldown, choose Query, Define Query.  
2. Choose the Location button in the lower left.  
3. In the 'Location Condition' dialog, 'All' is the default so simply choose OK.  
4. In the center of the 'Define Query' dialog, set the query mode to 'Draw'.  
5. Choose the Execute Query button to query in the objects.  

 

Finishing Up 
The geometry is now available in the current drawing in its translated form.  It can now be edited just like 
any other drawing object. 
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Coordinate Conversion Exercise 
In this exercise you will combine a drawing in Mississippi State Plane Coordinates with a series of USGS 
Digital Raster Graphics in UTM NAD 27 Meters.  The process will be the same regardless of the original or 
target coordinate system.   
 
 
We will begin by opening the drawing file query_2.dwg (or ch_7_1.dwg from the sample files folder) from 
the directory containing your course files.  This file contains the surface contours, haulroads, pit lines, 
ponds, and other features that were queried into a drawing in Chapter 5.  The drawing containing the USGS 
DRG images created in Chapter 6 will be queried into this drawing to convert the DRG images to the proper 
coordinate system. 
 

1. Open the drawing query_2.dwg (or ch_7_1.dwg) from the directory containing your class files. 
2. From the Map pulldown menu, choose Tools then Assign Global Coordinate System. 
3. In the Assign Global Coordinate System dialog, click Select Coordinate System in the Active Project 

area.   
4. Choose USA, Mississippi as the Category, and NAD 27, Mississippi State Planes, East Zone, US 

Foot, CORRECTED (from the collar information on the DRG) as the system. Click OK. 
5. In the Source Drawings area, click Select Drawings and select the drawing Image_1.dwg from 

Chapter 6 (or ch_6_1.dwg) from the directory containing your course files. Click OK 
6. Click Select Coordinate System in the Source Drawing area.  Choose UTM-NAD27 as the category 

and NAD27 UTM, Zone 16 North, Meter (from the collar information on the DRG) as the system.  
Click OK. 

7. Your dialog box should now look like the one below.  When it does, click OK. 

 
 
8. You now need to attach the source drawing to the Active Project.  Right click on Drawings in the 

Project Workspace and choose attach.  Select the drawing Image_1.dwg (or ch_6_1.dwg) and click 
add, then click OK. 

9. Double click Current Query in the Project Workspace to bring up the Define Query dialog box.  
Clear any queries listed, then click ‘Property’ as the query type. 

10. In the Property Condition dialog box, click Object Type.  Type IMAGE in the value box then click 
OK. 
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11. Be sure that Alter Properties is unchecked, and then click the drawings button.  Deactivate all of the 
attached drawings except for the one containing the DRG images.  Click OK. 

12. Set the Query Mode to Draw, and then click Execute Query. 
 
You should now see the four USGS DRG images on your drawing screen.  You may need to use the 
draworder command to send the images below the linework.  This process works the same regardless of 
the type of objects being queried.  Linework will be translated the same way as these images.  Save this 
drawing to the directory that contains your course files as Coords_1.dwg. 
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Chapter 8 Cleaning Up Drawings  
 
AutoCAD Map provides a powerful range of tools for editing mapping data.  The tools can be used to 
isolate selected data by breaking map objects where they cross a boundary, or by trimming objects and 
discarding data either inside or outside of a selected closed boundary.  AutoCAD Map provides the ability to 
automate the process of removing errors from map data. 
 
After you digitize or import a map, you must clean up the linework before you create a topology or 
perform a map analysis. 
 
Use the drawing cleanup tools to correct digitizing and scanning errors such as incomplete lines, broken 
intersections, or duplicate objects. You can reduce unnecessary details and create a seamless join for 
objects that cross from one map or another.  
 
In addition, you can break an object that crosses a specified line or trim objects inside or outside a 
boundary. 

Methods 
 

Boundary Breaking   
1. Allow you to break objects at the location where they cross a specified polygon. 
2. Creates vectors and polygons with start and points that straddle a cutting edge. 
3. Does not break objects such as blocks, text, hatch patterns, and other objects with insertion points 

that do not form edges. 
 

Boundary Trimming   
1. Removes unnecessary detail or isolates the features within an area. 
2. Similar to TRIM command, with the added options that the trimming boundary can be defined 

during the command or use a boundary from a previous query. 
3. An existing boundary must be a  circle or a closed polyline. 
4. Trimming inside a boundary clears information from an area, while trimming outside a boundary 

discards all the data outside the area of interest. 
5. Boundary Trim deletes data! 
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Types of Errors 
 
 
♦  Undershoots     
 
 
♦  Dangles    
 
 
♦  Crossings 
 
 
♦  Node Clusters 

   
 
♦  Duplicates   
 
 
   
 
♦  Shorts 
         
 
 
 
 
 
♦  Pseudo Nodes   
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Methods of Cleanup 
 
 

1. Identify all errors, mark each error, and correct the problems using edit commands and grips. 
 

2. Identify all errors, examine each error, and correct the problems with AutoCAD Map cleanup 
options. 

 
3. Identify one error type, correct it automatically, then move on to another type of error. 

 

AutoCAD Map Clean up Tools 
 
AutoCad Map provides tools for removing or correcting the several different types of digitizing errors 
previously discussed. 
 
The tools allow you: 
 
� Select Automatically, which uses all the available objects in the drawing (Points, blocks, and text, are 

not considered) 
 
� Select Manually lets you specify objects by picking, or with any selection set, such as All, Crossing, or 

Fence. 
 
� Filter Layers limits cleanup operations to the layers specified. 
 

Cleanup Procedures for Polygon Topologies 
 
Before you create a topology from map objects, make sure the objects are clean. To clean the linework in a 
drawing: 
 

1. From the Map menu, choose Tools → Drawing Cleanup. 
2. In the Drawing Cleanup dialog box, click Object Selection. 
3. In the Object Selection dialog box, specify how to select objects: 

 
� Select Automatically to use all objects. 
� Select Manually to choose the objects you want. Then click Select > and select the objects to 

use. 
� Select Filter Selected Objects to use only objects on the specified layers. 

 
Click OK to return to the Drawing Cleanup dialog box. 
 

4. In the Drawing Cleanup dialog box, click Cleanup Options. 
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5. In the Cleanup Options dialog box, select the cleanup options you want:  
 
 

Delete Duplicate Objects 
� Locate objects that share the same start and end points as well as all other points within the 

tolerance distance. Delete one of the objects. Note that even if the two objects have different 
linear directions, they are considered duplicates.  

� Specify the tolerance in the Edit Geometry Tolerance box. 
 

Erase Short Objects 
� Locate any objects shorter than the specified tolerance and erase them.  
� If the object is connected to other objects at each end, select Snap Clustered Nodes to have 

these objects snapped together and joined into one object. 
� Specify the tolerance in the Edit Geometry Tolerance box. 

 

Break Crossing Objects 
� Locate objects that cross each other with no node at the crossing. Break crossing objects and 

create a node at the crossing.  Note  When you use this option on multiple layers at the same 
time, it may create intersections for linear objects on separate layers that do not actually 
intersect. To avoid this problem, you can use the option on one layer at a time. 

 

Extend Undershoots 
� Locate objects that come within the specified tolerance radius of each other, but do not meet. 

If one object can be extended to cross the other, it will be snapped to an existing node that is 
within the specified tolerance. If no node exists, one will be created at the intersection. If two 
objects pass within the specified tolerance, they will be snapped at their closest point. If a 
node exists on either object within the specified tolerance of this point, the objects will be 
snapped to that node. If no node exists, one will be created at the point. 

� Specify the tolerance in the Edit Geometry Tolerance box. 
 

Snap Clustered Nodes 
� Locate any nodes within the specified tolerance radius distance of each other and snap them 

to the centermost node.  
� Specify the tolerance in the Edit Geometry Tolerance box. 

 

Dissolve Pseudo Nodes 
� Locate any node shared by only two objects. Dissolve the node and join the two objects. 

 

Erase Dangling Objects 
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� Locate objects with at least one end point that is not shared by another object, and erase the 
object. Set the tolerance slightly greater than the longest dangle you want to erase. Dangling 
objects do not include closed polylines. 

Note  It is often a good idea to use the Break Crossing Objects option before you erase dangling objects. 
 

Simplify Linear Objects 
� Simplify complex linear objects by removing all interior nodes that fall within the specified 

corridor tolerance.  Reducing the number of points in a detailed pline reduces file size and 
improves performance, but it also reduces the resolution of the data.  Line, arc, and polyline 
segments falling within the same corridor are generalized into a single polyline. However, 
branching points, dead ends, and endpoints of polylines are not generalized. Note  If your 
objects are lines, not plines, use the Dissolve Pseudo Nodes option to create a single pline. 

� In the Simplify Objects Tolerance box, enter the width of the corridor.  
 
 

6. In the Tolerance boxes, specify the tolerances for the above options. 
7. In the Correction Method area, specify how you want to correct errors: 

 
� Select Correct Automatically to have AutoCAD Map find and correct all errors that match 

the criteria.  
� Select Correct Manually to have AutoCAD Map prompt you at each error whether you want 

it corrected. Click Cleanup Markers to change the size, shape, or color of the markers used to 
mark the errors. 

 
8. Click OK to close the Cleanup Options dialog box. 
9. In the Drawing Cleanup dialog box, click OK to save your changes without performing a drawing 

cleanup. Or click Proceed to start the drawing cleanup operation. 

Boundary Breaking 

 
1. Open a project and attach the maps you want. 
2. Define and execute a query to retrieve the objects to break. 
3. From the Map menu, choose Tools → Boundary Break. 
4. Under Boundaries, choose how to specify the boundaries for breaking: 

 
� Use Save Back Extents of Active Source Drawings - Use the extents of the source drawing as 

boundaries. 
� Select Boundaries - Use objects in the project as boundaries. Click Select < and select the 

objects to use. The objects need to form a closed area. 
� Define Boundary - Use a boundary you define. Click Define < and specify the boundary. 

 
5. Under Objects to Break, specify whether to select objects manually or automatically, and whether to 

use only objects on selected layers. 
6. Under How to Break, specify whether to exclude topology objects, and whether to retain object data 

on the objects. 
7. Click OK. 
8. Save your changes back to the source drawings. 
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Boundary Trim 
 

1. Open a project and attach the maps you want. 
2. Define and execute a query to retrieve the objects to trim. 
3. From the Map menu, choose Tools → Boundary Trim. 
4. Under Boundaries, select how to specify the boundary: 

 
� Reference Last Query Boundary - Use the boundary you used in the last query. 
� Select Boundary - Use an object in the project as the boundary. Click Select < and select the 

object to use. The object needs to form a closed area. 
� Define Boundary - Use a boundary you define. Click Define < and specify the boundary. 

 
5. Under Objects to Trim, specify whether to select objects manually or automatically, and whether to 

use only objects on selected layers. 
6. Under Trim Method, specify whether to trim inside or outside the boundary. Specify whether to 

exclude topology objects, and whether to retain object data on the objects.  
� If object data is retained, it is duplicated on each piece of a trimmed object. 

 
7. Under Objects That Cannot Be Trimmed, specify what to do with text, hatch patterns, and blocks 

that cross the boundary. 
8. Click OK. 
9. To save the trim with your topology, save your changes back to the source drawings. 

 
If you want to save the trim results, but you don't want to modify the original topology, save the changes to 
a new project. From the File menu, choose Save As and specify a name for the project. 
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Exercise 
 
In this example you will perform edits and cleanup on a drawing in order to create a polygon topology.  We 
will use the automated tools provided with Drawing Cleanup. 
 
In most polygon topologies, overshoots, dangles, undershoots, and unbroken crossing links are not valid, 
and should be cleaned up.  Polygon topology is especially particular about the linework used to define a 
topology. 
 
The processing order in drawing cleanup is critical in determining how the drawing cleanup options work if 
you are operating on a complex drawing working one step at a time, here is a recommended order of 
cleanup: 
 

1. Any object conversion options 
2. Snap Clustered Nodes 
3. Break Crossing Objects 
4. Extend Undershoots, Break Crossing Objects 
5. Erase Dangling Objects 
6. Erase Short Objects, Snap Clustered Nodes 
7. Dissolve Pseudo Nodes 
8. Delete Duplicate Objects (always the very last operation, as many duplicates do not show up 

until all geometry conversion changes take place. 
 

Use the Process Manually option to check the changes in your data as you go.  It is important to remember 
that cleaning up drawings should be considered a process, rather than a single automated step. 
 
Lets begin this exercise by opening a new drawing.  The file we will be using is named 
Ex2703-1_xx.dwg.  This file should look like the screen capture below. 
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1. From the Map menu choose Tools, then choose Drawing Cleanup. 
2. In the Drawing Cleanup dialog box, Choose Object Selection. 
3. Choose Select Automatically, then choose Filter Selected Objects. 
4. For Layer Filters specify the Year_Polys layer. 

 
The Object Selection dialog box should look like this: 

 
5. Choose OK to return to the Drawing Cleanup dialog box. 

 
You will leave the Object Conversion options as they are, and go on to specify the Cleanup Options. 
 

1. In the Drawing Cleanup dialog box, choose Cleanup Options. 
2. Select the Snap Clustered Nodes, and clear all the other options 
3. In the Edit Geometry area, set a Tolerance of 18. 
4. Make sure that the Simplify Linear Objects option is not selected. 
5. Under Correction Method, choose Correct Manually. 
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You can set options for the marker sizes and shapes by choosing Cleanup Markers, but for this 
exercise, you will use the defaults.  The completed dialog box should look like this: 
 

 
 
 

6. Choose OK to close the Cleanup Options dialog box 
7. In the Drawing Cleanup dialog box, choose Proceed. 
 

The command identifies any occurrences of clustered nodes on the Year_Polys layer and lists them 
at the Command line.  To see where the duplicates are located, you create Markers. 
 

1. At the Command line, enter M for drawMarkers and press Enter. 
 

AutoCAD Map displays a marker for each set of node clusters found.  You can choose to leave the 
markers in place and exit the command or to let AutoCAD Map fix the problems itself; in this case, 
you will do the latter. 
 

2. At the Command line, enter A snapAll and press Enter. 
 

Now you fix the remaining problems in the map, one at a time.  It is possible to combine these 
corrections into one operation, but it is safer to work on each problem individually. 
 

3. In the Drawing Cleanup dialog box, choose Cleanup Options, and then clear the Snap Clustered 
Node Objects and select Break Crossing Objects.  Make sure the Tolerance is 0.1. 

 
The edit Geometry area of the dialog box should look like this. 
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4. Set the Correction Method to Correct Manually.  Then Choose OK. 
5. Choose Proceed. 
6. At the Command line, enter M for drawMarkers and press Enter. 
7. At the Command line, enter A breakAll and press Enter. 
 

When complete, use the ERASE command to manually remove the crossing lines.  Zoom in on the 
objects if you need to. 
 

 
Using the Drawing Cleanup command, complete these tasks one by one: 
 

1. Extend Undershoots with a tolerance of 15. 
2. Erase Dangling Objects with a tolerance of 20. 
3. Erase Short Objects of 10. 
4. Dissolve Pseudo Nodes with a tolerance of 0.1. 
5. Delete Duplicate Objects 
6. Save your drawing as cleanup_1.dwg in the directory that contains your course files. 
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Chapter 9 Object Data 
 
AutoCAD Map can store user-defined object information in drawings.  This information is called object 
data and can include permit number, operator name, acreage disturbed, status of permit, and number of acres 
reclaimed.  AutoCAD Map can also contain links between objects and external databases, but object data is 
actually contained in data tables in the drawing.  Object data queries retrieve objects based on object data 
values.  For example, if you have a regional drawing showing all permit boundary configurations for that 
coalfield, you can later query the drawing to display those permits that have acreages greater than X number 
of acres. 
 
 
Object data is stored as part of an AutoCAD Map drawing and cannot be viewed or edited by any 
application other than AutoCAD Map.  It is ideal in the following situations:  for relatively limited amounts 
of textual data that will be used in AutoCAD Map only; for data that does not require frequent or extensive 
editing; or for data where only one record is modified at a time.  Object data is also used to identify 
elements of a topology.  Examples of applications that might use object data include: 
 

� Details about haulroads in a permit map 
� Information about soil types or strata in a map 
� Drainage information in a watershed map 
� Distances between points on a core hole map 

 
 
 

Creating an Object Data Table 
 
 
When you define a new object data table, you define the fields in the table, a description, the data type for 
each field, and optionally, specify a default value to be used.  Make the description a useful name, because 
this is what is shown by the Attach/Detach Object Data and the Edit Object Data dialog boxes. 
 
 
There are four types of data that you can use.  The types are: 
 
 

Data Type Valid Values Sample Uses 

Integer 
Whole numbers between –2,147,483,648 
and 2,147,483,647 

Permit Number 

Character Any characters Company Name 
Point A list of three real numbers, separated by 

commas and representing a point with X, Y, 
and Z values 

Feature location for a 
ground water monitoring 
site 

Real A real number between 1.7E-308 and 
1.7E+308 

Contour Elevations, 
Haulroad Width 
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The Default is a value automatically assigned when you create a new object data record.  You can edit this 
field when you enter object data; in some cases, you might use the Default to show the format of the field. 
 

Entering Object Data Values 
 
 
Once an object data table is defined, you can create object data in a map by: 
 

� Manually entering it with the Add/Detach Object Data command on the Object Data Menu 
 

� Entering it as you digitize new objects in a map 
 

� Copying a drawing object already containing object data 
 

� Generating values from existing blocks and attributes in a map with the Generate Links 
option on the Database menu 

 
 
There are four options available to automatically generate object data linked to objects from existing text or 
attributes.  These are: 
 

� Blocks – Create links on the block based on block’s attribute values.  The target object data 
table’s field names must match the attribute tag names on the block. 

 
� Enclosed Blocks – Creates a link on a polyline enclosing a block based on a block’s attribute 

values.  The target object data table’s field names must match the attribute tag names on the 
block. 

 
� Enclosed Text – Creates links on a closed polyline that surrounds one piece of text.  This 

option works only if the target object data table has only one field. 
 

� Text – Creates a link on text object. 
 

Uses of Object Data 
 
 
Object data is far more useful than block attributes as it can be added to any object in a drawing, not just a 
block, and because data can be entered as a specific data type.  Defining the object data with drawing 
objects means that those objects can be retrieved by queries based on the values of the fields and used as the 
basis of thematic maps (these topics are covered in more detail in subsequent chapters). 
 
You can use object data to associate documents from other Windows applications with a specific drawing 
object, so that selecting an object allows you to view and edit an associated file. 
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Attaching Object Data to Objects 
 
Once you define an object data table, you can use the table to query and update the information associated 
with an object referenced in the table.  You can select a drawing object and view and edit the information 
referenced in the table displayed in a dialog box. 
 

An Example of Using Object Data Table 
 
Assume you have a polygon object for which you want to define data so that it completely represents the 
geometry and other information for a permit boundary.  You define an object data table in the drawing file, 
which allows you to access this data all at once.  The fields in the table can be defined to include field name, 
description, default values, and data type 
 
Once the object data has been attached to the object(s) in question, this information becomes a part of the 
drawing file.  If this drawing is then attached and activated from another drawing, the object data values can 
be used for querying specific objects.  The objects can be retrieved with queries based on object data values, 
such as permit number or identifier.  With object data, sophisticated thematic drawings and reports can be 
generated from a drawing.  Through the entity querying functions of AutoCAD Map, you can use a range 
table to alter the properties of objects differently depending on where their object data values fall within a 
given range. 
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Exercise 
 
CREATING AN OBJECT DATA TABLE 
In the following exercise, you will define an object data table for the haulroads drawing.  You will define 
the name of the table, and the field names and types in the table. 
 

1. Open the drawing haulroads_xx.dwg. 
2. From the Map menu, choose Object Data, and then choose Define Object Data. 

 
The Define Object Data dialog box shows any existing object data tables in the current drawing.  As well as 
creating a new table, you can modify, rename, or delete existing tables in this dialog box. 
 

3. Choose New Table 
4. Under Table Name, enter a name for the new table.  In this case, you will use the name 

HAULROADS. 
 

� Object data table names can be a maximum of 25 characters and contain 
alphanumeric characters only, with no spaces.  Each field in the object data table 
requires a name and data type, and optionally, a description and a default value.  
The field name can be alphanumeric with a maximum of 31 characters. 

 
5. Under Field Name, enter Haulroad_ID 
6. From the Type list, select Character 

 
7. The Description is used to identify fields in dialog boxes when you view or edit object data values, 

so you should give this field a useful name.  For Description, enter Haulroad Identification 
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8. To complete the field definition, choose Add. 

 
� Next, you will add another field. 

 
� Repeat steps 5 to 8 above for a field called Rd_Lgth, with a type of Real and a 

Description of Haulroad Length. 
� When complete, choose OK to close the Define New Object Data Table dialog box. 

9. Choose close in the Define Object Data dialog box to complete the definition. 
 
Now you will attach object data to the haulroad network. 
 

1. Set the current layer as Haulrds. 
2. From the map menu choose Object Data, then Attach/Detach Object Data. 
3. In the Attach/Detach Object Data dialog box, make sure that Table is set to Haulroads. 
4. Select the first Object Data Field, which has the description Haulroad Identification. 

� For Value, enter A and press enter  **You must press ENTER after you type a value in this 
dialog box, or else the value is not retained.** 

 
� For the Haulroad Length, enter 3.15 

The dialog box should look like this: 
 

 
 

� Under Action, choose Attach to Objects, and select the polyline that represents Haulroad A. 
� Press Enter to complete the command. 

5. Repeat above steps for Haulroads B thru E.  With the haulroads having the following length values: 
� Haulroad B 2.76 
� Haulroad C 3.47 
� Haulroad D 0.48 
� Haulroad E 0.15 
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The haulroads now have object data showing their names and length of each measured in 
miles.  Save this drawing as odata_1.dwg in the directory containing your course files. 
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Chapter 10 Topologies  
 
A topology is a group of connections that establishes how nodes, links, and polygons relate to one another.  
Topology is a geographic relationship between objects.  A simple CAD system will not deal with 
topologies.  To deal with topologies, you must have a GIS system.  Topologies allow a GIS to carry out 
analysis.   
 
There are three types of topology: 
� Node Topology: Related system of points or objects that can be used to analyze the relationships 

between points on a map, such as drill holes or gas wells.  Nodes have only one 
x,y location and occupy no area. 

� Network Topology: Connected links used to analyze linear, topographical features such as roads.  A 
link in a network topology can be given a direction value. 

� Polygon Topology: A series of areas, or polygons, enclosed by interconnected links.  A polygon 
topology can be used to analyze areas of land such as bond increments and land 
use. 

 
In addition to the drawing geometry, topologies consist of object data attached to the drawing objects. 
(Object data was covered in Chapter 9).  While a topology can create new node, no new links are created 
with a topology. 
 
Before a topology can be created, you must first go through the drawing cleanup tools to ensure that the 
drawing geometry is correct.  (Drawing cleanup is covered in Chapter 8). 
 
For this course, we will be concentrate mainly on polygon topologies.  Polygon topologies can be used to 
analyze bond areas, land use areas, or any other mapping feature that forms a polygon.  When you create a 
polygon topology, the object data for the polygon is attached to the “centroid”.  The “centroid” of a polygon 
topology is somewhat different from the geometric centroid of the area.  The centroid of a polygon topology 
can be placed anywhere within the boundaries of the polygon.  The centroid can be a point, a block, a piece 
of text, or any other object.   
 
The centroid of a polygon topology automatically has the number of links defining the polygon, the polygon 
id, and the area and perimeter of the polygon attached as object data.  You can also link database records to 
the centroid.  You can use both the object data and any other data linked to a polygon topology to perform 
queries and create reports and thematic maps. 
 

Creating Topologies 
 
After cleaning up the drawing geometry, you can create a topology.  The steps involved in creating a 
topology are outlined below. 
� Give the topology a name. 
� Choose the type of topology you would like to create. 
� Select the objects to include in the topology. 
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This table describes the functions of the Topology Objects options when you are creating a specific 
topology type.  The items in bold are required selections.  All other items are optional. 
 

Type Node Objects Link Objects Centroid Objects 

Node Selects the nodes 
for the topology -- -- 

Network 

Selects nodes to 
include or Creates 
new nodes from 
specific blocks or 
specific layers 

Selects the links for 
the topology. -- 

Polygon 

Selects nodes to 
include or Creates 
new nodes from 
specific blocks or 
specific layers 

Selects the links for 
the topology. 

Selects objects for 
centroids or Creates 
centroids from 
specific blocks or on 
specific layers. 

 
� If AutoCAD Map encounters any errors in the geometry of the drawing, it will end the topology 

creation and mark the errors with an X. 
� After the topology has been created, you can save it.  If the topology was created from queried 

objects, the topology can be saved back to the source drawings. 
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Topology Exercise 
 
In this exercise, you will use the drawing that you cleaned up in Chapter 8 to create a simple polygon 
topology for the year polygons. 
 
Begin by opening the drawing cleanup_1.dwg (or ch_10_1.dwg) from the directory that contains your 
course files.  After opening the drawing file, go the layer pulldown and thaw the layer “Text”. 
 
From the Map pulldown, choose Topology, and then Create.  This will open the Create Topology dialog 
box as shown below. 
 

 
 
In the Define Topology section, name the topology Year_Polys, set the type to polygon, and for the 
description, enter Mining Sequence Polygons.  When you have finished, the dialog should look like the one 
below. 
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In the Topology Objects section, click Link Objects, and then select all of the lines that define the polygons.  
In the Link Objects dialog, check Select Automatically, and check Filter Objects.  Click on the Layers 
button and choose the layer Year_Polys.  Click OK to return to the Link Objects dialog.  If your dialog box 
looks like the one below, click OK to return to the Create Topology dialog box 
 

 
 
 
Click Centroid Objects and then select each of the pieces of text that label the polygons.  In the Centroid 
Objects dialog, check the Select Automatically button, and check Filter Selected Objects.  Click the Layers 
button, and then choose the layer Text.  Click OK to return to the Centroid Objects dialog.  In the Object 
Creation section, set Create on Layer to centroid and Create Using to ACAD_POINT.  If your dialog box 
looks like the one below, click OK to return to the Create Topology dialog. 
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In the Create Topologies dialog, click Proceed to create the topology.  After the topology is created 
successfully, save the drawing as topology_1.dwg in the directory that contains your course files.  You will 
now need to view the object data attached to the centroids to see what was attached. 
 
From the Map pulldown menu, choose Object Data ���� Edit Object Data.  On the command line, you will 
be prompted to select the object.  Select any of the pieces of text that are within a polygon, or the points that 
were inserted in the polygons that had on internal text.  You will see a dialog box like the one below. 
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This shows the area (in square feet) and the perimeter (in feet) of the selected polygon.  The ID is the 
polygon identifier, and the LINKS_QTY shows how many links make up the polygon.  Clicking the Select 
Objects button will allow you to select another centroid in the drawing and see the data attached to it. 
 
After you have finished exploring the topology options, save the drawing as topology_1.dwg, and then 
close it. 
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Chapter 11 External Databases 

Working with External Databases 
 

Definitions 
•  Database:  a collection of textual information organized into tables, views, queries, and reports, all stored in one file.�
•  Table:  one part of a database with a data structure made of horizontal rows or records with vertical columns defining the 

data elements. 
•  Environment:  the database management software (DBMS), the databases it can access, and the users and programs that 

can access those databases. 
•  Catalog:  the directory path name that is the location of the database.�
•  Schema:  the catalog subdirectory where the database tables reside. 
•  Link:  consists of a link template and a value in the key column in a database.   
•  Link Template:  a five part address consisting of the environment, catalog, schema, table, and key columns.  A link 

template is stored as object data with each linked drawing object 
•  UDL:  stands for Universal Data Link.  A UDL lists the location and version of a database (or the location of a data 

source name (DSN)) and the appropriate database driver.�
 

Connecting a Database 
•  Three ways to connect a database 

1. Drag & Drop a database into the Project Workspace. 
2. Right click on Databases in the Project Workspace then select attach. 
3. Go to the Map pulldown menu and then select Database�Data Sources�Attach. 

•  You can also use a UDL from a database that was attached to a different project. 
•  All tables in the attached database are shown in the project workspace.�
•  The reference to the external database is maintained in the project.  The environment, catalog, and schema are 

written to the system registry. 
•  The databases are not attached to any source drawings at this point.  When the project is closed, all database 

connections are terminated. 
 

Viewing Data 
 

•  Three ways to open the Data View window. 
1) Double-click on a table in the Project Workspace. 
2) Right click on a table then choose Edit Table or View Table from the shortcut menu. 
3) Double-click on a Link Template or Query in the Project Workspace. 

•  These options show all records in the table. 
•  Records can be filtered using the Recordsè Filter command from the Data View menu. 
•  Records can be sorted by double-clicking on a column.  The first time you double click it is sorted in ascending order.  

The second time it is sorted in descending order. 
•  To sort multiple columns, choose the Sort Multiple Columns option from the view menu.  Choose the columns to sort 

and the records are sorted first on the first column values.  Then any duplicate values in the first column are sorted by the 
second column value and so on.  

•  If the table is opened in edit mode, you may change, add, or delete records.  You cannot change the table structure or the 
data type. 

•  Undo only works for one action in the Data View window. 
•  Add a new record by editing the last row (marked with an *).  When you move to another record, the new record is 

added to the database. 
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Defining Link Templates 
 

•  Two ways to define link templates 
1) Right-click on a database in the Project Workspace and choose Define Link Template from the shortcut menu. 
2) From the Map pulldown, choose Database � Define Link Template. 

•  In the Data View window choose Links � Define Link Template. 
•  In the Define Link Template dialog box, first give the template a name.  (31 characters maximum, no spaces or symbols) 
•  Next, choose the column or columns that you want to use as “key columns”�
� A “key column” is a column used to link records to objects. 

•  The new link template is shown in the Project Workspace and the Data View window. 
 

Linking Objects 
 

•  4 ways to link data 
1) Create the link as you digitize the object 
2) Copy a drawing that already has database links generated. 
3) Generate links from existing blocks and attributes in a map with the Database �Generate Links option in the Map 

menu. 
4) Click the Link button (looks like a short chain) in the Data View window. 

•  The generate links command has 4 options for link creation. 
1) Blocks:  links records to a block based on the blocks attribute values. 
2) Text:  links records to text objects 
3) Enclosed Blocks:  links records to a polyline that encloses a block. 
4) Enclosed text:  links records to a polyline that encloses a text object. 
� For both the block and enclosed block options, the attribute tag and the  table column name must match. 

 

Viewing Linked Records 
 

•  From the Data View window, linked records can be viewed by clicking the “View Linked Records” button then clicking 
an object in the drawing. 

•  The records linked to that object are shown as highlighted records in the Data View window. 
•  Viewing Linked Objects 
•  Objects linked to a record can be viewed by selecting the record in the Data View window and then clicking the “View 

Linked Objects” button. 
•  The objects linked to that record are shown in the drawing window.  With the correct settings, the linked objects are 

highlighted and the window zooms to the object. 
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Exercise 
 
Open the drawing drillholes.dwg from the directory that contains your course files.  Make sure that you 
project workspace is visible.  If the project workspace has been closed, you can reopen it by going to the 
Map pulldown menu and choosing Utilities ���� Project Workspace.  We will now attach a database named 
chem.dbf to this drawing. 
 
   Double click on the Data Sources folder in the Project Workspace.  You should get a dialog box like 
the one shown below.   
 

 
 
In the Files of type box, change the file type to dBase or FoxPro files and then navigate to the file chem.dbf 
in the directory that contains your course files.  Once you have selected chem.dbf, click open to attach the 
database file.    You will be asked to identify the database version.  Choose dBase IV and click OK.  If the 
database is attached properly, you should see data listed under the data sources folder with chem., dhloc, 
and queries listed below that. 
  

 
 
If you receive an error message after clicking on open, there could be a problem with the database 
configurations in Map.  Click OK in the error message dialog, and then you should see Data listed under the 
data sources folder with a small red “x” next t it.  The easiest way to fix this problem is to type dbconnect 
on the command line.  This will open the database connectivity menu and box.  The box should show up 
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somewhere near the Project Workspace.  You should see Data listed again in this box with a small red “x” 
on it.  If you double click on Data, you should get another error message.  Click on the “Configure” button 
in the lower right corner to configure the database.  You should get the dialog box shown below.   
 

 
  
Click on the Connection tab and click the radio button next to “Use data source name” and select The 
correct database type from the dropdown list.  This should be all that you need to connect to the database.  
The other options could be used, but this is the quickest and easiest way to go.  After you have set these 
options, click on OK. 
 
 
You should now see all of the tables in Data listed in the Data Sources area of the Dbconnect box.  Close 
this box, and then double click Data in the Project Workspace.  You should now have all of the tables listed 
in the Project Workspace.  Double click on the table named “Chem” and you should see the table displayed 
in a new window.  This table can be edited, sorted, queried, etc., just like any other database.  At this time, 
the database is not linked to any object in the drawing; it is just attached to the drawing.   
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In order to link object to the database, we must define a link template first.  To define a link template, right 
click on the link template folder in the Project Workspace and then choose “Define Link Template.”  You 
should get the dialog box shown below.   
 

 
 
The data source and table fields identify the specific table to be linked.  The link template field is where you 
can give the template a name.  The Key selection field allows the user to define which columns in the table 
are to be used to generate links.   
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For this exercise, we will be using the table named “chem” from the database named “data.”  For the Link 
Template name, type in “Coreholes” and check the box next to “dbsnum” in the Key Selection field.  Once 
this is finished, click ok.   
 
The next step is to generate the database links.  Right click on the Coreholes link template in the Project 
Workspace and then choose Generate Links.  You should get the Generate Links dialog box shown below. 

 

 
 
 

For this exercise, we will be linking to blocks.  This will create links to each block that has a value the same 
as the value in the DBSNUM column of the database.  Click the radio button next to Blocks, and click the 
radio button beside “Create Database Links”.  Be sure that the link Template is set to Coreholes.  On the 
Table dropdown, chose Chem, and for the block name choose SRVPNO1.  Make sure that Key 1 says 
DBSNUM next to it, and that Tag 1 is set to PT#.  Choose OK.  You will be prompted on the command line 
for the blocks to generate links from.  Hit enter to accept the default of all.  The command line should show 
417 links created.  There are actually only 13 coreholes in this drawing, but the link process has this 
database set up so that now if you enter a record for any of the 404 rotary drillholes, the record will 
automatically be linked to the block that represents that hole in the drawing. 
 
You can now view the linked records in the data view window.   You can double click on the table name in 
the project workspace to bring the table up in the Data View window. 
 
You can use the data view window to see what records are linked to an object, or vice versa.  To see what 
objects are linked to a given record, we need to set some options on the highlight menu.  Auto highlight will 
automatically highlight an object in the drawing when you select a record in the database linked to the 
drawing.  Auto zoom will automatically zoom in on the object in the drawing.  Auto select will select the 
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object that is linked to the selected record.  We want all three of these options turned on, so check to be sure 
that they are all three checked.  We also need to set up our auto zoom scale.  This controls how much 
AutoCAD will zoom in on the object that the record is linked to.  The larger the number you choose, the 
more of the screen the object will fill.  We will set the auto zoom scale to 20% for right now.  This will 
allow us to see where the selected object is in relation to the rest of the drawing.  To set the zoom scale, 
click on the highlight menu and then choose zoom scale.  The current zoom scale is also shown in the 
bottom right corner of the data view window.  You should now have the three options checked as they are 
below and the zoom scale set to 20%.   
 

 
 
The yellow square in the corner shows the color that records will be highlighted if you choose to highlight 
records linked to an object.  Click on any of the solid gray squares next to a record and see what happens on 
your drawing screen.  It should zoom in to a selected, highlighted point in the drawing. 
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As you see here, one of the records for 00NK is selected in the data view, and the point for corehole 00NK 
is highlighted, selected, and zoomed in on.  If you scroll down in the data view window and select a 
different record, you should see your drawing window change again.  Save this drawing as dbase_1.dwg in 
the directory that contains your course files. 
 

You can also do the reverse of this process.  If you click on the Highlight Linked Records button  then 
select an object in the drawing window, any records that are linked to the objects are highlighted in the data 
view window.  To only see the records that are highlighted, go to the Highlight pulldown and click on Show 
Highlighted Records Only. 
 
You can also filter the records in the table to find records that meet specific criteria, or to find records linked 
to objects within a certain area.  To filter records, you can go to the Records pulldown then choose either 

Spatial Filter or SQL Filter.  You can also use the filter buttons for special filter  or SQL filter .  In 
this exercise, you will filter for all of the records with a sand content greater than 30, and a pH less than or 
equal to 5.  You should find 16 records that match these criteria.  To see where the objects that the records 
are linked to are in the drawing, select all 16 records (using the shift or Control key).  The linked objects 
should be automatically highlighted and zoomed in on.  You may need to change the zoom scale in order to 
see the entire selection set easily.  To clear the filter and go back to viewing the entire table, click the clear 

filter button .  Take a few minutes to explore some of the other options that are available in the data 
view window, then save the drawing as dbase_1.dwg in the directory that contains your course files. 
 



Chapter 12 Editing Tools  AutoCAD Map for Permitting and Reclamation 

103 

Chapter 12 Map Editing Tools (Save Back)  
 
With AutoCAD Map, you can work with more than one drawing at a time, and use only the parts of the 
drawings that you need.  Multiple users can view and query objects in the same file on a network at the 
same time.  When you want to edit objects retrieved by a query, the objects are locked in the source drawing 
until you commit the changes you have made by a process called save back.  Once edited or newly created 
objects are saved back to the source drawings, the objects are unlocked and are available to all users again.   
 
When you use AutoCAD Map with multiple drawings, you usually want to perform one of two operations: 
review source drawings and create new drawings, or edit source drawings.  The following will help you 
decide which of these two operations you want to perform. 
 
� When you review source drawings and create new drawings, you perform one or more queries to examine the contents of 

source drawing files.  If you want, you can modify the objects using AutoCAD Map property alteration or standard 
AutoCAD editing commands to create a new drawing.  You do not edit the source drawings. 

 
� When you edit source drawings, you perform queries to retrieve objects that you modify and save back to the source 

drawings.  You create a set of changed or new objects called a save set.  If an object is not in the save set, AutoCAD 
Map does not save it back to the source drawings. 

 
Please note that you cannot use queries to transfer data from one source drawing to another.  If you want to 
do this, it is better to open the original drawing, and use Cut, Copy or Copy with Base Point from the Edit 
pull-down menu.  This transfers the selected data to the Windows Clipboard.  Then open the target drawing 
and use the appropriate Paste command from the Edit menu.  The data is inserted into the target drawing 
according to the parameters of the selected Paste command. 
 

 DRAWING LOCKING 
 
When you attach a drawing to a project, AutoCAD Map creates a lock file for that drawing.  The lock file is 
located in the same directory as the drawing file, and has the same file name, but has the extension .dwk.  
The lock file is typically a couple of KB in size.  The lock file does not prevent you or other AutoCAD Map 
users on a network from attaching the same drawing to a project, but it prevents you or them from opening 
the file with the Open option from the File menu or the OPEN command.  Normally, when a project 
drawing is closed the lock files are removed.  However, sometimes when AutoCAD Map is closed 
improperly (system crash, fatal error, etc.)  the lock files are not removed.  In this case, you need to go into 
the directory where the project drawing file and the source drawings are located and remove them manually. 
 

 EDITING SOURCE DRAWINGS 
 
If you intend to edit queried objects and save them back to source drawings, you must specify the objects 
you want to save by creating a save set.  If you create new objects, you can add them to the save set or save 
them directly to the source drawings.  Note that if you do not create a save set, the changes you make to 
queried objects will not be saved back to source drawings. 
 
The editing process involves the following general steps: 
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1. Open a project and attach the drawings to be edited. 
 

2. Use the query feature to retrieve objects for editing. 
 

3. Set the defaults for the Save Back feature in the AutoCAD Map Options dialog box. 
 

4. Use any command to modify a queried object. 
 

5. If you create new objects, add them to the save set. 
 

6. When finished editing, save the changes back to the source drawings. 
 

Save Back Options 
 
You can specify options for saving objects back to source drawings and set defaults for the Save Back 
feature.  From the Map pull-down menu, click on Options which brings up the AutoCAD Map Options 
dialog box and choose the Save Back tab.  
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Under Save Set, if you don’t want AutoCAD Map to add your changes to the save set automatically or to 
prompt you to add queried objects to the save set when you modify them, select the Don’t Add Objects 
Automatically option.  If you select this, in order to save your changes, you must add the modified objects to 
the save set manually.  To do this you go to the Map drop-down menu, select Save Back, then choose Add 
Objects to Save Set.   
 
If you do want to save changes to the save set, you can select whether AutoCAD Map prompts you to add 
queried objects to the save set as you modify them or if you want the modifications to be automatically 
added to the save set.  Please note that if you create new objects and want to save them to source drawings, 
you must add them to the save set using Add Objects to Save Set from the Map , Save Back pull-down menu.  
AutoCAD Map will not prompt you to add them. 
 
Continuing in the AutoCAD Map Options dialog box, Under Save Back to Source Drawings, select one or 
more of the following: 
 
� Redefine Block Definitions on Save Back - Use this option to save changes to block definitions back 

to the source drawing, including the insertion point and the objects in the block. 
 
� Redefine Layer Definitions on Save Back - Use this option to save changes to layer definitions back 

to the source drawing, including layer color and linetype. 
 
� Redefine Text Style Definitions on Save Back - Use this option to save changes to text style 

definitions back to the source drawing, including front, size, angle, orientation, and other text 
characteristics. 

 
� Remove Unused Groups on Save Back - Use this option to clear the source drawings of any groups 

that are empty after you save back, because you may have removed all objects from a group when 
you deleted objects.  You may want to review what groups are by referencing the online AutoCAD 
User’s Guide. 

 
� Erase Saved Back Objects - Use this option to remove the objects from the project drawing when 

you save back to source drawings.  If you do not select this option, new objects that have been saved 
back to the source drawings remain in the project. 

 
� Remove Locks from Saved Objects after Save - Use this option to release object locks when you 

save.  This option is available only if Erase Saved Back Objects is not selected. 
 
� Create History File of Changes - Use this option to create a file that records the changes you make 

to source drawings. 
 
� The history file uses the drawing name with the extension .hst.  It is located in the same directory as 

the drawing.  For each object, the history file lists the date the save back was issued, the handle of 
each changed object, the name of the user making the change, and the type of change (erased or 
modified). 

 
� Create Backup File of Source Drawing - Use this option to save source drawing backup files.  A 

backup file is created only before saving the project file and setting the projection parameters, not 
before saving object locks to the drawing file. 
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Exercise 
 
In the drawings of our mine site, we wish to modify how the haul roads are illustrated based on the life of 
the mine.  Attach all of the drawings in the directory that contains your course working files, then use quick 
view in the Project Workspace to view the drawing files HAULRDS.DWG and ex2703-1.dwg. 
 

 
 

The haul roads are represented in green and the polygons representing the yearly progression of the mine are 
represented in white (or black depending on your display settings).  Zoom in on the mine site and note that 
certain segments of haul roads service the mine for various periods of time during the life of the mine.  We 
want to represent years 1 - 15 with cyan, years 16 - 29 with yellow and years 31 - 37 with magenta.  The 
main north-south road will be represented in red. 
 
First we need to query the appropriate objects from these two drawings.  In the Project Workspace double 
click on Current Query.  
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We are going to restrict the query to the two drawings we want to query objects from.  This is not necessary 
to do if the objects you want to query are only found on a layer that only exists in the drawing you want to 
query.  However, if the drawing set contains more than one drawing with the same layer name and you 
don’t want to extract all objects on that layer from all the drawings, then you need to restrict the drawing set 
to those drawings you want to query from.  
 
In the Options area, select Drawings.  The Define/Modify Drawing Set dialog box appears.   
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Note that all of the drawings in the drawing set are active.  Click on the Select All button to select all of the 
drawings.   
 

 
The Deactivate button is now energized.  Select Deactivate.  Now all drawing files are still attached but are 
inactive.   
 

 
 
Search through the list of attached drawings and select, while holding down the Ctrl key,  the two files we 
are interested in querying, HAULRDS and ex2703-1.  Then select the Activate button. 
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Now only the two drawing files are active and will be the only ones that will be queried.  Click on OK to 
return to the Define Query dialog box. 
 
In the Define Query dialog box under Query Type select Property, which brings up the Property Condition 
dialog box.   
 

 
 
In the Property Condition dialog box, select Layer and click on the Values button. 
This brings up the Select dialog box which lists the layers that are available for querying from these two 
drawing files. 
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The objects we want to query are on the HAULRDS, TEXT AND YEAR_POLYS layers. 
Select these three layers while holding down the Ctrl key. 
 

 
 
Click OK to return to the Property Condition dialog box. 
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Notice that the three selected layers are in the value box.  Click OK to return to the Define Query dialog 
box. 
 

 
 
In the current query window you can see the property query that will extract objects on these three layers.  
To view the results of the query, select Preview and Execute Query.   
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To place the objects in the project drawing, double click on Current Query in the Project Workspace, select 
Draw and Execute Query.  Zoom to extents.   
 

 
 
Before we proceed to modify any of these objects, lets set our Save Back options.  From the Map menu, 
select Options.  Choose the Save Back tab in the AutoCAD Map Options dialog box.  Under Save Set, select 
Prompt to Add Objects.  Under Save Back to Source Drawings, check the boxes as shown in the example 
below.  For this example, our primary interest is to Erase Saved Back Objects from the project drawing, 
Create History File of Changes and to Create Backup File of Source Drawing.   
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Click on OK to set these Save Back options as default. 
 
In the drawing window, change the color property of the various segments of haul roads to reflect the 
following: Years 1 - 15 cyan, Years 16 - 29 yellow, Years 31 - 37 magenta and the main north-south 
segment to be red.  Open the Properties dialog box and select the segment of haul road transversing the 
polygons representing Years 13 - 29.  
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In the Properties dialog box, click on ByLayer of the Color property.  From the drop-down menu, select 
yellow. 

 
 
 When you do this, the Confirm Save Back window pops up in the drawing window. 
 

 
 
This is a result of setting the Save Back option to require a prompt before changes to objects are added to the 
save set.  Select Yes.  Clear the selection of this segment of haul road and select the north-south road 
segment.  Change its color to red and select Yes to the Confirm Save Back dialog box.  Likewise, change the 
segment for Years 1 - 15 to cyan and for Years 31 - 37 to magenta.  
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To see which objects are in the current save set, you can highlight them.  To do this, from the Map menu 
choose Save Back, then choose Show Objects in Save Set.  The modified objects will be highlighted in the 
drawing window. 

 
As you can see from the command line window, there are 4 objects in the save set.  These objects are 
highlighted in the drawing window.  Press <enter> to clear the highlighting of these objects. 
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Assume that after you have created this save set you want to remove an object from the set.  That is, you 
want to undo a modification you made to one or more of the objects that are now in the save set.  In this 
example, we would like to keep the original color of the segment of haul road servicing Years 1 - 15 which 
was green.  In the save set, we have changed that objects color to cyan.  In order to keep the source drawing 
from being modified, we need to remove this object from the save set.  From the Map menu, select Save 
Back, then choose Remove Objects from Save Set.   
 

 
 
At the command line prompt, hit <enter> 
 

 
 
You are prompted to select the objects you want to remove from the save set.  Select the cyan segment of 
the haul road.  To end the selection process, hit <enter>.  The Confirm dialog box pops up. 
 

 
 
To remove the selected object from the save set, choose Yes. 
 

 
 
AutoCAD Map responds indicating that 1 object has been removed from the save set.  You can confirm this 
by viewing the objects in the Save Set as was done earlier. 
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You will note that there are only 3 objects in the save set but the Year 1 - 15 segment is still cyan.  Since the 
cyan segment has been removed from the save set, this object in the source drawing will not be modified 
and it will retain its original color of ByLayer, which is green.  The queried segment that is in the project 
drawing has had its color property modified to cyan and if you want to change it back to ByLayer, that needs 
to be done using the Property dialog box (or using  another AutoCAD editing method).  If the need to 
change back to the original setting had been recognized right after the modification to cyan and the addition 
to the save set, then Undo would have changed the project drawing object back to its original state and 
would have removed the modification to cyan from the save back set. 
 
Something you should be aware of is that as long as you undo the changes made to the object(s) or remove 
them from the save set before you save the changes back to the source drawings, you are good to go.  If you 
have already saved back to the source drawings, the changes are committed and you would need to either 
open the source drawings and change the objects back to their previous state or you would need to re-query 
them and make the appropriate changes.   
 
To save back these 3 changes we have made to the source drawing, go to the Map menu, select Save Back, 
then choose Save to Source Drawings. 
 
The Save Objects to Source Drawings dialog box appears.  Sometimes this box appears automatically 
during the editing of objects.  This is because the Automatic Save option in AutoCAD Map displays the 
Save Objects to Source Drawings dialog box if there are objects in the save set.  You can choose to save 
back at that time or you can cancel the box and continue to edit.  However, the automatic save does not 
maintain the association between the source drawings and the project in the automatic save file called 
autoX.sv$ for the project drawing. 
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When you save back queried objects, AutoCAD Map saves them to their source drawings of origin.  Be sure 
that under What to Save, Save Queried Objects has been checked.  Choose OK to save the queried objects 
back to their source drawings. 
 
In the drawing window, note that the objects that were included in the save set have been erased.  
Remember that this was one of the Save Back options we selected earlier.   
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To verify that we have modified our source drawings first erase the remaining haul road segments in the 
project drawing.  When prompted to Add objects to save set?, choose No. 
 
Open the Current Query, which is our original query, check to see that Draw is selected, then choose 
Execute Query.   
 

 
 
Objects in the project drawing which also occur in the source drawings are not re-drawn but objects which 
do not exist in the project drawing but are in the queried source drawings are drawn based on the conditions 
of the query.  Since the haul roads have been erased from the project drawing, they are drawn based on what 
is in the source drawing.  The text and year polygons are not re-drawn.  You can see that the source 
drawings have been modified to reflect the changes in the color of respective segments of the haul roads. 
 
Next, we would like to add a new object to the source drawings.  This new object is a service road within 
the permit boundary but outside the haul roads.  We need to query the PRMTBDRY drawing to extract the 
permit boundary object so we can see where to construct our service road. 
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In the Project Workspace, select the PRMTBDRY drawing file, right-click and choose Activate from the 
shortcut menu. 
 

 
 
 
Double click Current Query in the Project Workspace, select the Property query in the Current Query 
window, then choose the Delete button.  Under Query Type, hit the Property button.  In the Property 
Condition dialog box, choose Layer. 
 

 
Hit the Values button and click on the PB layer in the Select dialog box. 
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Choose OK, to go back to the Property Condition dialog box.   
 

 
 
 
Click OK to accept this property query condition. 
 
Now we are back to the Define Query dialog box.   
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Set the Query Mode to Preview  
 

 
 
and then hit Execute Query.  Zoom to extents. 
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Re-run the query, but set the Query Mode to Draw. 
 
In the project drawing, create a new layer called SERVICE_RD, make its color cyan and make it current.  
Using a polyline, starting and ending at the intersection of the red and green lines in the southeastern area of 
the permit, draw a line outside the work areas but inside the permit boundary.  Make it 50 % the width of the 
haul roads. 
 
To save the newly created service road to the save set, from the Map menu, select Save Back, then choose 
Add Objects to Save Set. 
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At the Add objects to save set prompt, type S for Select , <enter>, and at the Select objects prompt click on 
the newly created service road polyline. [Selecting <allNew> would add all objects created since the start of 
the project]. 
 

 
 
 
 
 
To end the selection, hit <enter>. 
 

 
 
You can see that 1 object was added to the save set.  You can verify this by choosing Show Objects in Save 
Set from the Map, Save Back menu. 
 
To save this newly created object to a source drawing, go to the Map menu, Save Back, and choose Save to 
Source Drawings.  The Save Objects to Source Drawings dialog box appears. 
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Under What to Save, be sure the Save Newly Created Objects box is checked.  You can control how 
AutoCAD Map saves objects by specifying a save order priority for save back options.  This is done in the 
Save Order for Newly Created Objects section of the dialog box. 
 

 
 
To specify how you want to save new objects to source drawings, you can select a drawing for each new 
object, or you can save objects by area or layer.  AutoCAD Map uses your setting for save option 1 first 
when saving new objects to source drawings.  If AutoCAD Map is unable to save objects using this method, 
it uses the setting for save order option 2, and likewise for save option 3. 
 
If you are querying a single source drawing, AutoCAD Map sets the Save Order for Newly Created Objects 
to None and saves the objects back to the drawing automatically.  Remember that queried objects always go 
back to their source drawing.   
 
It is important to note that the order in which the source drawings are attached is important when AutoCAD 
Map works its way through these options when saving back newly created objects.  We can now take a more 
detailed look at the save order options for newly created objects. 
 
� Selective - Saves just the objects you select manually in the source drawing you specify. 

 
� Area - Saves new objects in tiled drawings to the source drawing within whose Save Back extents 

the object lie.  By default, the Save Back extents correspond to the drawings extents, but they can be 
changed in the Drawing Settings dialog box.  If the new object crosses the boundary of more than 
one drawing, AutoCAD Map saves it in the first selected drawing that it intersects in the list of 
active drawings.  Therefore, the order of attached drawings may be an important consideration. 

 
� Layer - Saves new objects to layers in the source drawings that use the same names as the projects 

layers on which the objects lie.  If more than one active drawing contains a given layer name, 
AutoCAD Map saves the object to the first selected drawing that contains that layer in the list of 
active drawings.  For example, if an object is on LAYER_A in the project, and you have LAYER_A 
in drawingA, drawingB, and drawingC, AutoCAD Map saves the object to drawingA, the first in the 
list of active drawings.  Again, the order of attached, active drawings is important. 

 
� None - Disables all other save back options.  For example, if you only want to manually specify the 

objects to save and the source drawings in which to save them, set the first save back option to 
Selective, and set the other two options to None. 
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In this example, note that in the Drawings to Save New Objects to window, all three of the active drawings 
are selected.  
 

 
 
Choose OK, and we are prompted to select the objects to be saved to the drawing ex2703-1 since it is the 
first drawing in the selected list. 
 

 
 
Since all three drawings are selected, AutoCAD Map will process them in the order listed.  If we try to 
bypass saving this new object to the ex2703-1 drawing by hitting <enter> without selecting the polyline, the 
Area method in Option 2 will be applied since the drawing extents of ex2703-1 and the extents of the 
polyline in the project drawing overlap.  As a consequence, the service road polyline will be saved to the 
ex2703-1 drawing.  Hit ESC to cancel the command. 
 

 
 
Answer Yes to the Cancel save back operation? prompt in the Save Objects to Source Drawings dialog box. 
 
If  we had selected None for Options 2 and 3 before we hit OK, we could have used this procedure to save 
the polyline to the HAULRDS drawing.  In that case, by hitting <enter> without selecting the object when 
prompted to save newly created objects to the ex2703-1 drawing, we would have been prompted to select 
objects to be saved to the HAULRDS drawing.  After selecting the polyline and hitting <enter>, the object 
would have been saved to the HAULRDS drawing and erased from the project drawing. 
 
There is another way we can save the newly created service road object to the HAULRDS source drawing.  
We want to exclusively use the Selective method for saving, so set Option 1 to Selective, and the other two 
options to None.   Also select the HAULRDS drawing in the window. 
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Choose OK and you are prompted to select the newly created objects to be saved to the HAULRDS 
drawing. 

 
 
Select the service road polyline with the pointing device and hit <enter>. 
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AutoCAD Map will tell you that 1 object was saved and you can see that the object was deleted from the 
project drawing according to the default Save Back options.  Construct a new query to verify that the service 
road was saved to the HAULRDS drawing.  Save this drawing as Saveback_1.dwg in the directory that 
contains your course files. 
 
You can  have several new objects and save them to different drawings.  Have the new objects in the save 
set.  In the Save Objects to Source Drawings dialog box, set Option 1 to Selective and the other options to 
None.  Select the drawings that you want to save the objects back to from the list of drawings in the 
Drawings to Save New Objects to window.  Choose OK, then when prompted to select new objects to be 
saved to a particular drawing, select those objects with the pointing device.  When all objects that are to be 
saved to that drawing are selected, hit <enter>.  Those objects are then saved to that drawing and you will 
be prompted to select objects to be saved to the next drawing in the list.  Continue until all objects have been 
saved to their appropriate drawing.  The saved objects retain all the object properties it had in the project.  If 
the object is on a project layer that does not exist in the source drawing, AutoCAD Map creates that layer in 
the source drawing. 
 
You can display the Save Objects to Source Drawings dialog box by executing the SAVE, QUIT, NEW, or 
OPEN commands.  The commands QUIT, NEW, and OPEN give you the opportunity to discard edits.  If 
you choose to save your edits, the Save Objects to Source Drawings dialog box appears.   
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Chapter 13 Plotting  

Plotter Configuration 
 

In this exercise, you will configure an existing system plotter to be used as a default throughout this 
exercise.  You will use an HP 750C plotter that has already been installed as a windows system printer; this 
exercise does not cover printer/plotter installation.  
 
Note: If you do not have an HP 750C installed on your system, you can substitute your preferred 
alternative. 
 
Select “Plotter Manager” from the “File” menu pulldown. 
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Select “Add-A-Plotter Wizard” from the “…Plotters” window. 
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The “Add Plotter - Introduction Page” window is displayed.  
 
Note that the wizard can configure an existing system plotter as well as a non-system plotter… and you can 
import PCP and/or PC2 configuration files that you may have set up/used with earlier versions of 
AutoCAD. 
 
Click “Next” on the “Add Plotter – Introduction Page” window. 
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Select “System Printer” from the “Add Plotter – Begin” screen. 
 
Note on the left side of the screen that “Begin, System Printer, Import PCP or PC2, Plotter Name, and 
Finish” are highlighted.  These highlights represent the screens/steps that the wizard will guide you through 
to complete configuration. Different steps are highlighted when “My Computer” or “Network Plotter 
Server” is selected. 
 
Click “Next” on the “Add Plotter – Begin” screen. 
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The “Add Plotter – System Printer” window is displayed.   
 
Scroll down the list of system plotters to highlight the one that you want to select (the HP 750C plotter or 
your preferred alternative if the HP 750C is not available on your system.). 
 
Click “Next” to continue. 
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The “Add Plotter – Import PCP or PC2” window is displayed. 
 
If you have created and saved PCP or PC2 plotter configuration files under previous versions of AutoCAD, 
you can import them here for use with the selected plotter in AutoCAD 2000.  This is accomplished by 
clicking on “Import File…” and navigating to and selecting the desired existing PCP or PC2 file. 
 
No existing configuration files are to be imported in this exercise.   
 
Click “Next” to continue. 
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The “Add Plotter – Plotter Name” window is displayed. 
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Enter “HP750C_TRAINING” as the plotter name. 
 
Then click “Next” to continue. 
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The “Add Plotter – Finish” screen is displayed. 
 
At this point you could alter the default plotter configuration settings and/or calibrate the plotter.  For this 
exercise, leave the default settings and calibration. 
 
Default plotter configuration settings can be changed/saved at any time much in the same way as any 
“Windows” system printer (In AutoCAD, this is accomplished by selecting “Plotter Manager” from the 
“File” menu dropdown, and then double-clicking on the plotter that you want to change.) 
 
Click “Finish” to complete plotter configuration. 
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The new “HP750C_TRAINING.pc3” configuration will be added to your list of plotters. 
 
Close the plotters list window by clicking on “X” to complete the exercise.  
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Default Page Setup 
 
For this exercise, you will use the file query_2.dwg (or ch_7_1.dwg).  Open this drawing and then select 
“Page Setup” from the “File” pulldown menu. 
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Click on the “Plot Device” tab to enable plotter selection. 
 



AutoCAD Map for Permitting and Reclamation Chapter 13 Plotting 

142 

Under Plotter configuration, select the configured plotter (i.e., HP 750C TRAINING.pc3 or the configured 
plotter of your choice.). 
 

 
 
Note that you can change the plotter configuration from this screen by clicking on the “Properties…” 
screen button. 
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Click on the “Layout Settings” tab to enable the layout settings window. 
 
Note the default settings for: 
 
 Paper Size / Units 
 Drawing Orientation 

Plot Area 
 Plot Scale 
 Plot Offset 
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Change Plot Area to the “Extents” to plot the drawing extents. 
 
Note that the Plot Scale changes automatically so that the drawing extents will fit on the selected paper size. 
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Change the paper size by selecting ANSI D – 22 x 34 in. (landscape) from the menu dropdown. 
 
Select “Center the plot” in the Plot offset area. 
 

 
 
Note that the plot scale changed to 1 inch = 1576 drawing units.  From that, we know that the drawing will 
fit on the selected paper size (i.e., 22 x 34-inch sheet) at that scale or smaller. 
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Under Plot scale, change the scale to 1 inch = 2000 drawing units so that the plot is produced at an easily 
readable/measurable scale. 
 
Note that the drawing can be directly plotted from this window by clicking on the Plot button at the bottom.  Do not plot at this 
time; you will plot directly from the plot window in the next exercise. 
 
Click on “OK” to close the Page Setup window. 
 

 
 
Save the edited settings by selecting “Save” from the “File” menu dropdown.  The drawing will now default 
to these page / plot settings every time it is opened. 
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Plotting from Model Space 
 
Select “Plot…” from the AutoCAD “File” menu pulldown. 
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The Plot window is displayed/opened. 
 
Note that except for the preview buttons at the bottom, it is the same as the Page Setup window that you 
used previously to select the plotter and alter the default plot settings. 
 
Click on the “Full Preview…” button at the bottom. 
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A “preview” of the plot is displayed.  Note the command line. 
 
“Right-click” (press the right button) on your mouse to display a shortcut menu. 
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Note that you can exit, plot, or perform various zooms from the shortcut menu. 
 
Select “Exit” to return to the main Plot window (Pressing ESC or ENTER in the previous window would 
also have displayed the main Plot window.). 
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After verifying that the plotter is turned on and the appropriate paper is loaded, select “OK” to plot the 
drawing. 
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 Creating Layouts in Paper Space 
 

Notice that when the drawing opens, the view defaults to Model space (note the “Model” tab at the bottom 
of the drawing window is highlighted/active and a “Model” button appears at the bottom of the AutoCAD 
window.).  
 
Model space is the area where drawings are normally created / edited.  You also can plot directly from 
model space as shown in the previous exercise. 
 
AutoCAD is set up to allow custom views of a drawing to be displayed and plotted as “Layouts” in Paper 
space.  Paper space represents the actual page to be plotted. 
 
Clicking on the Model button at the bottom of the screen toggles the drawing between Model and Paper 
space. 
 
Note also that two Layouts are created automatically when a drawing is created. 
 
Click on “Layout 1” tab to change to Paper Space. 
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AutoCAD switches to the “Layout” view and the Page Setup window appears. 
 
Note:  If you have previously created a layout, the page setup screen will not automatically appear.  If this 
occurs, select “Page Setup” from the AutoCAD “File” menu. 
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Click on the “Plot Device” tab in the Page Setup window and make sure that the desired plotter is selected 
(in this exercise, the plotter is “HP750C_TRAINING.pc3”).   
 
To select the plotter, click on the down arrow button in the “Plotter configuration” area, and scroll to / click 
on the appropriate plotter. 
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Next, click on the “Layout Settings” tab. 
 
Under Layout Settings, click on the Paper size menu and scroll to/ select “ANSI D –22 x 34 in. 
(landscape)”. 
 
Note the other settings: 
 
 Layout name (default “Layout 1”) 
 Page setup name ( default / no specific name) 
 Scale (default 1:1) 
 Plot area (default “Layout”) 
 Plot offset (default “0”) 
 Plot options (default “plot with plot styles” & “plot paperspace last”) 
 
These settings can be changed at any time by changing to the Layout/Paper space mode and selecting “Page 
Setup” from the AutoCAD “File” menu pulldown. 
 
Click “OK” to finalize the layout settings and display the created layout. 
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A single viewport layout has been created that will plot the drawing extents on a 22” X 34” sheet using the 
HP750C_TRAINING plotter configuration. 
 
Multiple viewports can be created on a single layout/page.  Although not included in this example, note that additional viewports 
can be added/inserted by selecting “Viewports/ New Viewports…” from the AutoCAD View dropdown menu.  
 
Note that the display is Layout 1 (Layout 1 tab is highlighted/active) and in paper space (“Paper” button 
replaced “Model” button at bottom right of AutoCAD window.). 
 
The paper plot area is represented by a dashed line. 
 
The drawing “viewport” is represented by a solid line around the drawing. 
 
The viewport size, position, and scale properties are automatically set so that the entire drawing is visible.  
You can view/alter the properties in paper space in the same way as any drawing properties are 
viewed/edited. 
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Viewport Properties 
 
While in paper space mode (i.e., PAPER button is visible on lower right hand side of AutoCAD window), 
viewport properties can be viewed and changed like any drawing properties. 
 
Select the viewport by clicking on the solid line around the drawing; the line grips will become visible. 
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After the viewport is selected, open and view the properties window by clicking the right mouse button and 
then scrolling to / selecting “Properties” from the menu. 
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The “Properties” window for the viewport is displayed. 
 
Scroll up and down to review the viewport properties. 
 
Note that the viewport scale is 0.0006  
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Editing Viewport Properties : Scale 
 
The existing viewport scale factor of 0.0006 equates to 1 plotted inch = 1667 drawing units.  Drawing units 
in this example are “Feet,” so the plotted scale is 1”=1667’. 
 
We want the drawing to plot at 1” = 1000’, so the scale factor would be1/1000 or 0.001. 
 
Click on the scale row and change the scale (factor) to 0.001. 
 
Then click anywhere on the drawing to apply the new scale to the viewport. 
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Next, close the properties window by clicking on the “X” in the upper right hand corner. 
 
Layout 1 remains with the viewport at a scale of 1” = 1000’. 
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Editing Viewport Size / Position 
 
Note that when you alter the scale, the entire drawing may no longer be visible in the viewport.  You will 
have to change the position and/or size of the viewport so that the desired portion of the drawing is visible 
at the chosen scale. 
 
If not already done, click on the viewport outline to select/ highlight the line grips. 
 
Click on the grips on the corners to select (grip will turn red). 
 
Move the grips to a position so that only the mine working area is visible.  
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Next, you must position (i.e., move) the viewport towards the center of the layout/sheet to allow space for 
the title block.  In the layout view, the viewport can be “moved” like any other entity/block in AutoCAD 
using the “Move” command. 
 
If not already done, select the viewport by clicking on the solid line around the drawing. 
 
Next, begin the AutoCAD “Move” command by selecting “Move” from the “Modify” dropdown menu. 
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As directed on the command line, you must specify a base point. 
 
You have the option of  “clicking” on any desired point on the drawing or manually entering a point 
specification on the command line.  Click the lower left corner of the viewport as the base point.  You will 
now be prompted for the displacement.  Move the mouse on the screen and the viewport will move with it.  
When you have the viewport approximately in the center of the sheet, click again to place it there. 
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Inserting Title Blocks 
 
In this exercise, you will insert a pre-defined title block to complete the layout sheet. 
 
Make a new layer called Title Block and make it current. 
 
Select “Block…” from the “Insert” menu dropdown. 
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Navigate to and select D_Plot_Title.dwg from the directory containing your course files. 
 
Click “Open” to insert the block. 
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Verify that the X, Y, and Z Scales are set to “1.0”. 
 
Verify that there is a check mark next to “Specify On-screen” in the “Insertion Point” area. 
 
Click “OK” to continue. 
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Position the title block so that it centered on the sheet (i.e., within the dashed lines) and around the viewport.  
After position is selected, “Click” the left mouse button to set/finalize title block insertion.  On the 
command line, you will be prompted to give your name, the date, the scale of the drawing, the drawing title, 
and the drawing number.  Fill these in, then hit enter and the title block will be displayed. 
 
If necessary, re-size/position the viewport (as shown in the previous exercise) so that it can fit inside the title block area. 
 
This completes the sample layout; the drawing is ready for plotting. 
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Plotting From Paper Space 
 
While remaining in the Layout 1 view, select “Plot…” from the AutoCAD “File” menu pulldown. 
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The Plot window is displayed with plot settings as specified during the layout creation process (Part VI. 
Creating a Layout). 
 
Verify that the correct/desired plot device is specified and that paper size is ANSI D – 22 x 34 in. 
(landscape). 
 
Also note that “Layout” is selected under “Plot area” and the “Plot scale” is “1 inches = 1 drawing units”. 
 
When plotting from layouts, the scale should generally be 1:1 as one of the purposes of using layouts in paper space is to set-up 
and view your drawing/portions of your drawing in a viewport of pre-determined scale (i.e., if you set up a viewport at a scale of 
1 inch = 200 feet, and then change the scale in the plot window, the viewport scale(s) will no longer be valid when plotted.). 
 
Click on the “Full Preview…” button at the bottom of the window. 
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A “preview” of the plot is displayed. 
 
Once you review the plot and verify it is what you expected, press “ESC” or “Enter” to return to the plot 
window. 
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After verifying that the plotter is turned on and the appropriate paper is loaded, select “OK” to plot the 
drawing. 
 

 
 
Once plotting is complete, save the drawing as plot_1.dwg, and then close the drawing. 
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Chapter 14 Student Notes 

Useful CAD and GIS Related Websites 
 
TIPS Website: http://www.tips.osmre.gov/ 
 
GIS Data Depot: http://www.gisdatadepot.com/catalog/US/sublist.html 
 
AutoDesk Point A: http://pointa02.autodesk.com/portal/nav/index.htm 
 
Carlson Software (SurvCADD): http://www.carlsonsw.com/ 
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